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Introduction: Why WonderLogix?
The Programmable Logic Controller has been a fact of industrial life since the late
1960s, and PLCs of many kinds are found wherever high-reliability automation is
required, in factories that manufacture all types of products, and installations, large and
small, handling everything from water to nuclear power. Since 1993 the IEC 61131-3
has set standards for basic software architecture and programming languages for the
control program within the PLC, and major names, such as such as Rockwell
Automation, Siemens and Schneider Electric provide provide design solutions for
programming.
So, after all this time, in such a well-established industry, what can WonderLogix
possibly add to the mix?
A solution to a problem that everyone sees but no one notices: Control software
development is broken.
So let’s fix it.

What's Broken?
What we at WonderLogix have seen, after a combined quarter-century of experience in
process design and industrial control, is how often the commissioning of major projects
like power plants, water treatment facilities, and chemical plants, is marred by:
• Millions of dollars of damage and production losses
• Never-ending commissioning
• Continuous misunderstanding with customers

What We Have is a Failure to Communicate
Process and control engineers need to cooperate in order to create control software, but
the truth is that they speak different languages.
PROCESS ENGINEERS define how a facility should operate using functional specs.
However:
• Definitions rarely have a standard format
• Definitions are usually not simulated or optimized
• There are practically no supporting tools for preparing specs
This results, in many cases, in vague, inaccurate, and incomplete definitions.
CONTROL ENGINEERS, in contrast, program the facility’s PLC according to the process
engineer’s definitions.
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Through no fault of their own, due to these communication challenges, control
engineers are likely to misinterpret definitions. And, because they use primitive
programming environments they are also likely to cause errors in complex manual
coding.
And this results in poor-quality controller code.

The Costs of Poor Quality Code
Bad control code isn't just sloppy. It carries a huge cost in the form of lost revenue,
reduced employee motivation, and dissatisfied customers. Consider this:
Fact

Source
Stratus, “The total cost of downtime in
industrial automation”, 2016

$20B

Annual cost of managing unscheduled
downtime and accidents across process
industries

70%

Delays in the commissioning of industrial G.W. Gunther Reinhart, “Economic
projects that are attributed to errors in PLC application of virtual commissioning to
mechatronic production systems”, Prod.
code
Eng. Res. Devel, vol. 1, 2007

20%

Accidents in industrial control plants that
are due to programming errors

ARIA database, la reference du retour
d’experience sur accidents technologiques,
page 32

49%

Systems integrators who say that hiring
engineering talent is their key challenge

Control Engineering, “Control Engineering
2016 System Integration Study”

So this is not only about losing money. We’re talking about risking human lives.

First Admit You Have a Problem
It’s all well and good to point fingers at what’s wrong, but unless someone can come up
with a solution, what’s the point of complaining?
The point is that, over fifty years ago, the problem was identified, tackled, and solved.
It was just never applied to process design and industrial control.

The Software Crisis
The problem was called the Software Crisis: when computers began to get so powerful
that software development couldn’t keep up. This resulted in
• Projects running over-budget
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•
•
•
•
•
•

Projects running over-time
Inefficient software
Low quality software
Software that did not meet requirements
Unmanageable projects
Difficult code maintenance

Sound familiar?

Control Engineering is Software
In control engineering, we often fail to understand that we are dealing with software.
This failure is the root cause of many safety issues and incidents within automation.
In other words, PLC code is much more software than electrical engineering, and needs
to be treated as such.
The good news is, we aren’t the first to deal with software failures and we don’t need to
reinvent the wheel to fix this problem. The “Software Crisis,” when software became the
expensive component in computerized systems, and the bottleneck in their
maintenance, was resolved by developing and new discipline, called SOFTWARE
ENGINEERING.
We now can take the goals, principles, and methodologies of software engineering,
apply them to PLC code, and enjoy all the benefits it offers.
The goals of software engineering define good software as:
• Reliable: It should behave as it is intended to over the long term
• Understandable: It should be easy to anticipate its behavior and, later on, correct
any mistakes
• Modifiable: It should be easy to make specific changes without damaging other parts
of the software

WonderLogix: A Framework for Success
Looking at PLC coding through the lens of software engineering gives the world of
process control a different perspective.
Using this vision, we at WonderLogix came up with a framework to systematically
develop successful PLC code.
1. We chose an appropriate methodology: Methodology (page 4)
2. We defined a protocol to explicitly define requirements: Functional Specs (page 4)
3. We devised a platform to standardize and reuse code: Reuse and Standardization
(page 5)
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4. We developed tools for simulation and troubleshooting: Simulation (page 5)
5. We worked out best practices to prepare for commissioning: Commissioning (page 6)
Today, WonderLogix Studio is a mature software platform, developed in light of the
methodology of software engineering, which guides you, as you work, in its
implementation.
We invite you to continue reading about the framework we developed for our own use
which can still be implemented with a traditional programming process. Or feel free to
jump to one of the sections that teach you how to use it.
• Getting Started (page 11)
• Common Practices (page 23)
• Learning How to Use WonderLogix Studio (page 45)
• Exercise 1: Lubrication System (page 47)

Methodology
Several methodologies have been developed to assist in fulfilling software engineering
goals, and the most commonly adopted one is the object-oriented paradigm.
WonderLogix, too, decided that object oriented design offered the best solution for PLC
programming for the following reasons:
• Modularity
• Ability for reuse
• Ease in design (by the ability to break down complex problems into small pieces)
• Simple to modify
• Easier and safer maintenance

Functional Specs
Creating functional specs is, by far, the most crucial and basic step for the development
of process control design, but it is often the weakest link in the chain. A functional spec
should tell a high level story while providing all of the small details. It should be ready
as soon as possible but always kept up to date.
Fulfilling these contradictory requirements seems like an impossible mission, especially
considering that there are hardly any dedicated tools for preparing functional specs.
This usually means developing this fundamental building block using Word documents,
Excel sheets, flowcharts, or some combination.
Nevertheless, the functional spec is your way of saying what you want, and this
document is the basis for the communication between all parties in the project, from
process to control.
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So, it’s essential to invest time and thought into the design stage in order to quickly and
accurately arrive at the next stage.
Your functional spec should, of course, also be subject to the chosen methodology or, at
least, represent a preliminary stage in creating a more detailed spec according to the
chosen principles.
Eventually, your code will implement the story you define. So, for that reason, your
design should be so precise that there is no room for interpretations, and so explicit
that a technician, not a programmer, could easily translate them into code.
The advantage is clear: although you’ll work a bit harder in the design stage, your
definitions will not undergo any changes due to issues of interpretation.
Now, let’s take it a step further. Imagine that your definitions could be so precise, that
even a machine could translate them to code. Think of the precision, the speed, and the
code safety due to standardization, that could be achieved in this way!
In fact, this is how WonderLogix Studio works. There is no need for traditional, manual
programming. Logic requirements are entered in plain English which minimizes room
for human error. The system generates both the code and full documentation
automatically.

Reuse and Standardization
Reusing tested and predefined components is a significant time- and cost-saver for
design and debugging.
In WonderLogix Studio you can reuse anything from the smallest control modules to an
entire production line.
For instance, one of our clients developed the control of a subsystem for circulating
water in repeating cycles, including the control of the pump and all the transmitters.
Later, they took the design, as a tested black box, to their next project.
In order to do this, you’ll have to code or design in a structured way that supports
reuse. And the result will not only be in time and money saving but also in increased
reliability and safety.

Simulation
Before commissioning, spend ample time checking your code. When you properly
troubleshoot, you can repair any issue preemptively.
Every hour of in-office simulation saves time and money. On-site repairs cost 30 times
more than in-office repairs, according to some research. In other words, two hours
simulating processes, troubleshooting problems, and working out repair procedures, can
save sixty hours actual troubleshooting and repair in the field.

WonderLogix Studio User Guide
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On-site, however, you must deal with real materials, fluids, and more. The lack of
testing and simulation can cause dangerous mistakes, in addition to the loss of time and
money.
In
•
•
•
•

order to achieve good simulation
Allocate enough time
Plan scenarios and test them
Think of start up and shutdown scenarios
Imagine as many anomalies as you can. Don’t limit yourself to simulating only the
proper process, in the most desirable conditions, and steady-state.

Comprehensive simulation and safety go hand in hand.

Commissioning
Commissioning is the final stage of your project, and one of the most important.
Commissioning is expensive and stressful and you will be under pressure to wrap it up
quickly so that production can begin—but resist the temptation.
By sticking to your methodology, you are laying the groundwork for years of successful
operation. Remember, the right way is often the long way.
By keeping your conventions during the commissioning process, your code will remain
well structured, paying off years down the road. You’ll avoid costly mistakes, pricey
maintenance, and immobilizing accidents.

Conclusion
Industrial control software today is much more than connecting a few relays. By
embracing methodologies that were developed for other types of software—software that
already encountered and solved these exact difficulties decades ago—we can
dramatically improve the quality of our code and gain safety and efficiency throughout
the lifetime of the facility.
The link between code quality and facility effectiveness is clear. If you improve your
code quality, you improve your facility. It’s as simple as that.
Although, as we said before, this proposed framework can be used for traditional design
and manual programming, WonderLogix Studio is a computerized platform that wraps
this framework into a product that guides you in developing your projects according to
that framework.
WonderLogix Studio does that in the following way:
• It implements the object oriented design methodology completely, in a graphical way
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• It offers improved methods to communicate explicit requirements and prevents any
misinterpretations
• Reuse and standardization are built-in, out-of-the-box; you can reuse blocks through
classes or by exporting them to other projects
• Basic simulation is included, and further extensions and improvements are in
progress
The idea is simple. While frameworks, good as they may be, rely mostly on your self
discipline, a computerized platform that guides you—while keeping you within the
constraints of this framework—is most likely to help you implement it for the
successful operation of your projects.
For a deeper dive into the theory of object-oriented design, to go Software Engineering
and Object Oriented Design (page 1).
For an in the weeds discussion of the structure and building blocks of a WonderLogix
Studio project, go to Concepts (page 105).
To learn how to get started with WonderLogix Studio, go to Getting Started (page 11)
and Common Practices (page 23).
Or, just jump in feet first by going to
• Learning How to Use WonderLogix Studio (page 45)
• Exercise 1: Lubrication System (page 47)
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Overview
WonderLogix Studio is an advanced platform for designing industrial control systems in
a fast, easy, and reliable way. It is based on the principles of object-oriented design and
a unique patented technology which allows for easy and accurate definition of logic
requirements in plain English.

Requirements
WonderLogix Studio is a cloud-based software and requires a continuous Internet
connection. WonderLogix Studio is installed on your computer and its projects are
saved locally. The current installer is for Windows 64 bit systems.

Files
WonderLogix Studio uses two proprietary file types.
File Type

Explanation

WSP

WonderLogix Studio Project to save a complete project. Saved by default
under: C:\Users\<username>\WonderLogix Studio\Projects

WSO

WonderLogix Studio Object to save part of a project. Saved by default under:
C:\Users\<username>\WonderLogix Studio\Library

The WonderLogix Studio Workspace
The main screen of WonderLogix Studio is shown below.
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Figure 1: WonderLogix Studio Workplace

(A)

(B)

(C)

(D) (E)

(F)

(A) Left panel: data relevant to the entire project
• Model navigation tree
• Components 107
• Lists
(B) Current component
(C) Central area
(D) Right panel: data relevant to the current component
• Project description
• State machines 17
• Properties 115
• Parameters 116
(E) Search
(F) Notification area
(G) The left panel includes data relevant to the whole project: model navigation tree,
classes, and lists. The central area displays a certain part of the model: a
component, called the Current component, and its directly contained components,
called sub-components. The right panel displays data relevant to the Current
component: description, state machines, properties, and parameters. In addition, a
top bar contains a menu and search tool. Notifications are displayed at the bottom
of the screen. Other screens are displayed as part of more specific features.
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Here are instructions for getting started.

Installing, Activating, and Creating Your First Project.
To Install WonderLogix Studio, run the supplied installer and follow the displayed
instructions. The current installer is for Windows 64 bit systems.
When running WonderLogix Studio for the first time, enter your username (email) and
password in the activation screen. The installation is then attached to your account.
Note:

First-time loading takes longer than usual.

Caution:

Do not use WonderLogix Studio simultaneously on multiple copies of the same
virtual machine with the same username. This might corrupt your projects.

When starting the application, use the splash screen to create a new project or open an
existing one. Click New Project and type the name of the system you’re designing to
open the WonderLogix Studio workspace.

Managing Projects
You can open more projects, either new or existing, from the File top menu. All opened
projects are displayed under the View top menu, where you can select which project is
displayed on the workspace.
Note:

You cannot open multiple instances of WonderLogix Studio simultaneously.

The active project can also be saved, saved as, or closed from the File top menu.
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Figure 2: Three open projects displayed under View, with Filtering System currently active
Figure 3: Managing Projects

Building a Project
Adding and Modifying Components
When creating a new project, the workspace initially displays only a rectangle with the
name of the project. This rectangle represents the system you’re building. To add
subcomponents to it, do one of the following:
• Click the plus sign (+) at the bottom of the component
• In the context menu of the component, select Add Component
• In the top menu, select Add > Component
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Figure 4: Adding and Modifying Components

In the Create New Component window type a name for the subcomponent you wish to
add. You are warned if the name does not meet the length and characters limitations or
is not unique.
Select the Physical checkbox if you are adding a physical component.
To keep building the structure, zoom into one of the components you added (see
navigation) and add more components inside it. You can modify the name, description,
tag number, labels and type of a component in its Details panel. To open the Details
panel, do one of the following:
• Double-click the component name.
• Right-click a component or attribute to display its context menu.
• In the top menu, with the component you want to display details for selected, select
View > Details.
• In the context menu of the component, select Details.
You can turn an existing logical component into a physical one by selecting the Physical
checkbox in its Details panel, but only if this component is “empty”—it contains no
other components and has no logic defined on its outputs.
If you unselect Physical in the Details panel, the component becomes a logical
component and a copy of the physical component it formerly contained is placed inside
it. This is useful when you want to add functionality to a physical component, such as
making a valve that previously only received an Open command to also have an internal

WonderLogix Studio User Guide
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mode (Auto or Manual). The physical component must be wrapped in a logical
component to supply this functionality.

Creating Classes and Instances
A class is created from an existing component by selecting Create Class from its context
menu. Enter a name and optional description for the class. The class is added to the list
of available classes on the left panel.
To add one or more instances of a class from the classes list, do one of the following:
• Click the plus (+) icon of the class.
• In the top menu, with the class you want to add instance of selected, select Add>
Instance(s).
• In the context menu of the class, select Add> Instance(s).
In the Add Instances window you may add a single instance or multiple instances
(which may be inside an array). When adding multiple instances, the name you typed is
appended by a numeric or alphabetical suffix (1,2,3 or A, B, C).
Figure 5: Creating Classes and Instances

An array named Pump Units is created with three elements: Pump Unit 1, Pump Unit 2
and Pump Unit 3. Labels and initial values are copied to all Pump Units from the master
Pump Unit.
When a new instance is created, you may select to copy non-duplicating4 data to it.
This data is copied from a specific instance called the Master. One of the instances of

14

support@wonderlogix.com • 1-855-WLOGX5

Building a Project

each class is defined as the Master. You can make an instance the master by selecting Set
as Master from its context menu.

Creating Duplications
To create a duplication, first copy the component you want to duplicate by doing one
of the following:
• In the top menu, with the component you want to duplicate selected, select Edit>
Copy.
• In the context menu of the component you want to duplicate, select Copy.
Then, where you want to add the duplicated component as a child, do one of the
following:
• In the top menu, with Current selected, select Edit> Paste.
• In the context menu of Current, select Paste.
In the Paste Options window type a name for the duplicated component and select
which non-duplicating data to copy from the copied component.
Note:

It is highly recommended to use classes, and not duplication, whenever possible.

Modifying the Structure
A few additional operations allow you to modify the structure of the model: Make Array,
Lower, and Break Link.
Non-duplicating data includes tag numbers, labels, descriptions, and most values of
attributes.

Make Array
Use Make Array to group components of the same class (contained in the same
component) into an array. To make an array, first select the components you want to
group by selecting them while holding the Control key. Then, do one of the following:
• In the top menu, with Current selected, select Edit> Make Array
• In the context menu of one of the selected components, while still holding the
Control key, select Make Array to open the Make Array window. Give a name to the
array, and rename its elements if indicated.

Lower
Use Lower to move one subcomponent into another, thus lowering the moved
subcomponent one level down in the tree. You cannot lower a subcomponent into an

WonderLogix Studio User Guide
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instance of a class or into a locked component.
To lower a subcomponent, do one of the following:
• Drag a subcomponent on the subcomponent into which you want to lower it. Valid
destination subcomponents are colored green.
• In the top menu, with the component you want to lower selected, select Edit> Lower.
Then choose the destination in the Lower window.
• In the context menu of the component you want to lower, select Lower. Then choose
the destination in the Lower window.

Break Link
Use Break Link to disconnect a component from its class or the classes of components
above it in the tree. This is useful when you need to modify a specific component
without affecting all other components that otherwise would be affected because of their
link.
To Break Link, do one of the following:
• In the top menu, with the component you want to modify selected, select Edit>
Break Link.
• In the context menu of the component you want to modify selected, select Break
Link.

Adding and Modifying Attributes
To add attributes to a component, do one of the following:
• Click the plus sign (+) on the left side of a component to add an input and on the
right side of the component to add an output.
• To add a state machine, property or parameter, click the plus sign (+) on the header
of the appropriate box on the right panel.
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Figure 6: Adding and Modifying Attributes

• In the context menu of the component, select Add Attribute and select the type of the
attribute.
• In the top menu, select Add > Attribute and select the type of the attribute. In the
Create New Attribute window type a name for the attribute you wish to add. You will
be warned if the name is not unique or does not meet the length and characters
limitations.
You can modify the name, description, tag number, labels, data type, initial value and
HMI Write access of an attribute in its Details panel.
To open the Details panel, do one of the following:
• Double-click the attribute name (for all components except for state machines).
• In the top menu, with the attribute you want to display details for selected, select
View > Details.
• In the context menu of the attribute, select Details.

Creating a State Machine
To build a state machine after it is added, do one of the following:
• Double-click the state machine attribute
• In the top menu, with the state machine selected, select View > State Diagram.
• In the context menu of the state machine, select State Diagram.
In the state diagram window build the state machine by adding states and transitions.
To add a state, click the Add State button, type a name for the state and provide an
optional description.
You must define one of the states as the initial state. To do so, in the context menu of
the state you want to make initial, select Make Initial State.

WonderLogix Studio User Guide
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To add a transition, click the Transitions button. Complete the logic sentence to describe
the transition you would like to define. You can define a transition from multiple states
to the target state.
Note:

Transitions from a state to itself are not recommended. For that reason, the target
state is disabled among the source states.

You can change the color of each state or transition from its context menu.

Creating a Bitset
A bitset is a special parameter containing 32 bits. It is used to send and receive multiple
Boolean variables in a more concise way—typically to or from the HMI.
To create a bitset, add a parameter as follows:
1. Open component’s Details panel.
2. Change its data type to Bitset.
3. Click the small button with an ellipsis that appears near the parameter once it is
turned into a bitset.
4. In the Bitset Mapping window define the HMI Access for each bit you want to use:
• Read – The HMI reads this bit, which has the value of a specific Boolean attribute
in its scope. To select which Boolean attribute is mapped to this bit, click in the
mapped column and click on the attribute. If you select the Invert checkbox, the
value of the bit will be inverted to the value of the mapped attribute. A
description is usually not required.
• Write – The HMI writes to this bit.

Adding and Modifying Logic
Logic is added in the logic editor. To open the logic editor, do one of the following:
• Double-click the logic rectangle of the attribute to with you want to add logic.
• In the context menu of the attribute you want to add logic to, select Logic Editor.
• In the top menu, with the attribute you want to add logic to selected, select Edit>
Logic Editor.
There are several operations that you can do in the logic sentence that appears to
construct a sentence that describes the functionality you want:
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1. In each dropdown menu, select the suitable option. Options with gray background
describe the anticipated change if this option is selected, for example add time
constraint. Options that are connected with a line are logically equivalent. Select the
one that sounds best.
Figure 7: Adding and Modifying Logic

2. In each yellow rectangle with several options, select the suitable option by clicking
the ellipsis button at its end. Each option has an icon describing its data-type.
Figure 8: Adding and Modifying Logic Options

3. Enter values into the numeric fields. In the image above, you can change 0.0 to any
other numerical value.
4. Finalize the sentence by clicking the check button.
To edit a logic sentence, click the edit icon. To delete a logic sentence, click the delete
icon.
Figure 9: Deleting and Editing Logic

WonderLogix Studio User Guide
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Importing and Exporting
You can import and export any component or class of your model. The exported part is
saved in a .wso (WonderLogix Studio Object) file. To export a component, do one of
the following:
• In the context menu of the component to export, select Export.
• In the top menu, with the component you want to export selected, select Edit>
Export.
To export a class, in the context menu of the class to export, select Export. In the Export
To File window type a name for the exported component and an optional description.
You can lock the exported component with or without a password. Click OK and select
where and under what name to save the generated .wso file.
To import a .wso file, do one of the following:
• On the left panel, in the Classes list header, click the plus sign (+).
• In the top menu, under Add, select Class.
Note:

Select a .wso file to import. The imported class is added to the classes list.
When a class is imported, all contained classes are also imported, unless they
already exist in the classes list. If an imported class has the same name as an
already existing, but different, class, a time stamp is appended to the name of
the imported class.

Navigating
You can zoom into a component, zoom out to its parent or jump to any logical
component in the model. To zoom in, do one of the following:
• Double-click the lower part of the component you want to zoom into.
• In the top menu, with the component you want to zoom into selected, select View >
Zoom-in.
• In the context menu of the component you want to zoom into, select Zoom-in.
To zoom out, do one of the following:
• Click the zoom-out icon of the component you want to zoom out from.
• In the top menu, with the component you want to zoom out from selected, select
View > Zoom-out.
• In the context menu of the component you want to zoom out from, select Zoom-out.
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You can jump to any logical component by clicking it in the navigation tree. You can
also jump to any search result by clicking it, or jump to the master of any class by
selecting Go to Master in the context menu of the class.
Note:

The navigation tree is also used to display information (verification results and the
instances of a class). Click the release icon to close the information display and go
back to navigation mode where the tree automatically collapses and expands.
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How to Build a Model
This section describes the basic practice of building a model.
A
•
•
•

model is built in three principal steps:
Build the model’s structure
Define the interface of each component
Implement the functionality of each component

These steps may be implemented one after the other throughout the model or within a
specific scope.
Follow these guidelines for naming components and attributes
• Names should be descriptive, accurate, and clear.
• Use spaces between words to make them more readable.
• Because spaces are removed in the PLC, always capitalize the first letter of each
word.
Note:

We recommend turning on automatic capitalization.

Building the Model’s Structure
The model’s tree structure is usually built in a top-down manner by recursively adding
subcomponents to a component. It is also possible to build the model in a bottom-up
manner by lowering existing components into another component.

Use Nouns for the Names of Components
When trying to decide what components should be created, of what type, and in what
structure, follow the guidelines below. As an illustration we will use a tank with level
measurement filled through a filling valve.
Physical components are the only way for the model to interact with physical devices.
In other words, I/O is always tied to physical components: a signal sent to a physical
component (it is an input of the physical component) is a physical output (of the
control system) and a signal received from a physical component (it is an output of the
physical component) is a physical input (of the control system). A physical component
cannot contain other components—it is always a leaf within the tree structure.
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A logical component should contain other components that serve its functionality, even
if they are not physically part of it.
In our example, a tank logical component represents the part of the control system that
manages the tank. The Tank component should contain a Level Transmitter component,
since the level transmitter is required for managing the tank. The fact that the level
transmitter is physically contained in the tank is of lesser importance. If a requirement
to keep the tank level above a certain minimal level were introduced, then it would be
reasonable to also include a Filling Valve component in the Tank component so that the
Tank component can command it to open when the level is too low. The fact that the
filling valve is not physically contained within the tank in this case is of lesser
importance.

Components Should Clearly Represent Distinct Parts of the System
Physical components should represent recognizable physical devices of the controlled
system, such as Level Switch LSL-101.
Logical components should represent parts of the control system with specific
functionality. These components are typically grouped into bigger logical components
in order to represent higher-level functionality. This allows for better understanding,
and easier modification, of the model.

Consider Shared Resources
When a system serves additional multiple systems (i.e., it is a shared resource), it cannot
be contained by the multiple systems it serves. Typically, it would be placed in the
lowest level still accessible to all served systems.
Consider, for example, multiple tanks all filled by the same pump. Each tank must be
able to request pump operation when it needs filling. In this case, the Filling Pump
component represents a shared resource, and therefore it cannot be contained by any
tank component.
Each component should be as potent and independent of other components as possible.
Such modular design has many advantages, among them easy reuse. In the example, if
the level transmitter is not placed inside the tank, the ability of the tank to manage
itself is impaired if, for example, it must report that it is empty when its level decreases
below a certain level held in an internal parameter. In addition, it becomes coupled
with the level transmitter and cannot easily be duplicated.

Anticipate Changes in Design, Especially Duplications
Try to think of possible future changes to the design, and specifically, which
components might be duplicated in such changes. Try to think of a similar project that
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will reuse the components you defined. Such an examination might reveal the strengths
and weaknesses of the way the model is structured.
As an example, assume a tank is filled by a pump. Should the Filling Pump component
be contained in the Tank component? Think of what would happen in the design of a
bigger facility with multiple tanks. Would these tanks all be filled by a common single
pump or would each tank have its own filling pump? Such reasoning might help you
understand what is the preferred structure.

Creating Similar Components
If you need to create similar components, consider the following options:
• Express the difference between the components as a difference in the values of their
parameters—not their structure. Then, create all similar components as instances of
the same class, each with the right value.
For example, a Fail-Open Valve and a Fail-Closed Valve can be represented as two
instances of the same Valve class, differing only in the value of a parameter called
Fail-Open, set to True for the first instance and False for the second instance.
• Create a class for encapsulating similar parts and use its instances in similar
components
For example, a Heating Tank and a Stirring Tank, both with level measurement, cannot
be represented as two instances of the same class since they differ substantially.
However, their level measurement is identical. You may create the tanks as follows:
1. Create a Tank component containing a Level Transmitter component.
2. Make the Level Transmitter a class.
3. Copy/Paste the tank to get two non-connected tanks with connected Level
Transmitter.
4. Complete each tank by adding a Heater or Stirrer.
Optionally, you can create a class out of each tank.

Defining the Interface of Each Component
By defining the component’s inputs, the functionality it can support is established. As
the outputs are required for other components, they can be added when needed.
When naming interface attributes, follow these guidelines:
• Use verbs for Boolean inputs that request an operation from the component (Operate,
Open, Enable).
• Use verbal action for Boolean outputs that request an operation from another
component (Start Blower).
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• Use adjectives for Boolean outputs that report the status of the component. Avoid
prepositions, as these are already included in the logic sentences. For example, Full is
preferable to Is Full, Wash Done to Wash is Done.
• Use adjectives for Analog outputs.

Implementing the Functionality of Each Component
This includes adding internal attributes that are required for implementing the
functionality and defining logic. By defining logic wherever expected, the interaction
between different components is defined.
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Software Engineering and Object Oriented
Design
Software engineering deals with many different aspects of software, including
requirements, design, construction, testing, maintenance, quality, and management. This
chapter focuses on DESIGN and CONSTRUCTION of software. These topics are at the heart
of software engineering, and are the most relevant ones to industrial control systems
software, and form the core principles of WonderLogix Studio.

Goals of Software Engineering
First, let us define the goals we are trying to achieve. What constitutes good software?
One answer consists of four software goals:
• Reliability
• Understandability
• Modifiability
• Efficiency

Reliability
RELIABILITY means the ability of software to function as intended during periods of time
that are as long as deemed necessary. This goal is doubly important for software for
industrial control systems, since such systems function autonomously, over long periods
of time, controlling equipment whose faulty operation may cause great risks, damage, or
losses.

Understandability
UNDERSTANDABILITY bridges the gap between the problem to its solution. For a system to be
understandable, it must model reality as accurately as possible. The more complex the problem,
the more important is a clearly and efficiently structured solution.
Understandability is achieved on several levels. On the lower level, it necessitates order
and consistency. On the higher levels, it requires the ability to isolate different parts of
the solution and to see their relations to the real world.
At all levels, documentation plays a pivotal role in achieving understandability.
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Modifiability
MODIFIABILITY denotes the ease of making certain changes to the software (due to a
revealed error or a change in system requirements) without damaging other parts of the
software or changing design decisions. If a program is patched without regard to the
original design, the architecture will grow less and less clear, and changes will become
progressively more difficult to implement.

Efficiency
EFFICIENCY means making optimal use of available resources: processor, memory, and
devices.
Note:

We didn't mention this goal in the discussion about WonderLogix: A Framework for
Success (page 3) because, in recent years, PLCs have become so powerful they are
rarely the problem in control system performance.

Occasionally, these goals might clash. In such cases, these goals should be optimally
balanced.

Question:
Which would you consider the most important goal that should be achieved in
industrial control systems software?
1. Reliability
2. Understandability
3. Modifiability
4. Efficiency

Answer:
1. Correct: Industrial control systems are evaluated based on their ability to function as
required through long periods of time, which is the very definition of RELIABILITY.
Additionally, errors in industrial control systems software might cause substantial risks,
damages or losses, which is not the case for software used in many other fields.
2, 3: UNDERSTANDABILITY and MODIFIABILITY usually affect some other, more important,
goal.
4: EFFICIENCY is usually of secondary importance for industrial control system software,
as such software does not usually include complex algorithms and data structures where
the efficiency of implementation might be crucial.
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Principles of Software Engineering
Several PRINCIPLES of software engineering are ordinarily used in order to achieve the
aforementioned software goals:
• Abstraction
• Information Hiding
• Separation of Interface and Implementation
• Modularity
• Localization
• Uniformity
• Completeness
• Sufficiency
• Primitiveness
• Anticipating Change

Abstraction, Information Hiding, and Separation of Interface and
Implementation
The principles of ABSTRACTION, INFORMATION HIDING, and SEPARATION OF INTERFACE AND
IMPLEMENTATION serve to tackle the complexity of software, which manifests in a large
number of details that one may not perceive all at the same time.
ABSTRACTION means referring to essential details while ignoring non-essential details,
according to context.
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Figure 10: Ballpoint Pen

(A)

(B)

(C)

For example, one might treat the object above (A) at several different levels of
abstraction.
• A writing implement
• A pen
• A blue ballpoint pen
The “correct” level of abstraction depends on context:
• A person who is in a hurry to write down a telephone number is well served by the
highest level of abstraction: writing implement. The essential quality is the writing
capabilities, and it little matters whether the implement chosen is a pen or pencil.
• A person who needs to write a check is best served by the middle level of
abstraction: a pen. The highest level of abstraction is not detailed enough, as other
writing implements, such as a pencil, will not do. The lowest level of abstraction is
too detailed and includes some data which is not pertinent in this context: the type
and color of pen.
• A person who needs to sign a contract with two carbon copies requires the lowest
level of abstraction: a blue ballpoint pen. In this context, the type and color of the
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pen are important: a ballpoint pen is needed in order to make use of the carbon
paper, and red ink, for example, might be unacceptable.
The principles of INFORMATION HIDING and SEPARATION OF INTERFACE
IMPLEMENTATION complement the principle of ABSTRACTION.

AND

INFORMATION HIDING means making details which do not belong at the current level of
abstraction inaccessible. Specifically, one should aspire to keep the implementation of
an object (at a certain level of abstraction) hidden, while its interface—that is, its
connection with the outside world—is public.
SEPARATION OF INTERFACE AND IMPLEMENTATION further entails the independence of
interface from implementation, that is to say, the interface does not necessitate a certain
implementation and, likewise, implementation does not necessitate a certain interface.
For example, consider the interface of a ballpoint pen (B), which consists of a button
and a tip. A person is able to use the pen by its interface—that is, to press the button in
order to retract the tip, and to write by sliding the tip across the paper.
However, the implementation of the pen (C)—that is, the spring mechanism used to
retract the tip when the button is pressed, and the ballpoint mechanism that allows the
pen to produce a line of ink on the paper—is hidden.
The ability to change the ink holder of the pen to, for example, provide better ink flow,
while maintaining the ability to use the pen in precisely the same way, is a good
example of separation of interface and implementation.
INFORMATION HIDING and SEPARATION OF INTERFACE AND IMPLEMENTATION confer several
advantages for software:
• Attention is focused on abstraction at its highest level, and the user is spared a large
number of unnecessary details. In the pen example: in order to retract the point of
the pen, one need only know how to press the button, with no need to understand
the structure of the retraction mechanism.
It is easier to avoid damaging the hidden parts. In the pen example: there is little
danger of the delicate retraction mechanism being damaged while using the pen, as
it is well hidden within the body of the pen.
• The higher level does not depend on the details of the lower level. In the pen
example: using the pen is not dependent upon the type of ink holder.
Implementing the principles of ABSTRACTION, INFORMATION HIDING, and SEPARATION OF
INTERFACE AND IMPLEMENTATION in software contribute a great deal to achieving software
engineering goals. Abstraction serves mainly to enhance understandability and
modifiability. Information hiding, and separation of interface and implementation
contribute chiefly to understandability and reliability.
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Modularity and Localization
A MODULAR structure is one that is based on separate components. Modular design
enables the design, construction, understanding, testing and repairing of each module to
be independent, to some extent, of other modules. One consequence of modular
structure is the possibility of reusing modules.
For example, a pen with a separately inserted ink holder is more modular than a pen
which is built as a single unit. When a pen runs out of ink, a pen with an ink holder
can be easily “fixed” by replacing the ink holder. Fixing a pen built as a single unit is
considerably more difficult. Additionally, pen manufacturers may manufacture different
pens and use the same sort of ink holder for each of them, that is, they may reuse the
ink holder module.
There are two means of measuring modularity: COUPLING and COHESION. Coupling is the
degree to which each module relies on each of the other modules. Cohesion is a
measure of how strongly related or focused the responsibilities of a single module are.
Modules should ideally have weak Coupling and strong Cohesion. Each module should have a
well-defined interface.
Modularity is often hierarchical, meaning that the system is made out of modules which
are themselves made out of modules, and so forth. There are two distinct ways of
viewing hierarchical modularity:
• Top-down (each module is broken down into component modules and so forth)
• Bottom-up (each module is created out of component modules and so forth).
Often both methods are used in conjunction.
Here follows a (partial) top-down description of a ballpoint pen.
• The ballpoint pen is made out of body, button and retraction mechanism and ink
holder.
• The ink holder is made out of a hull, ink and point.
• The point is made out of an ink tube, a ball and a label.
L OCALIZATION means concentrating related things at the same location.
For example, the controls for a car’s headlights, turn signal indicators, and high- and
low-beams should be concentrated on a single lever.
Likewise, the windshield wipers and washer should be controlled from one location.

Uniformity
UNIFORMITY means avoiding unnecessary variations. Uniformity requires consistency in
structure, representation, style, and naming, among other properties. The principle of
uniformity is important for achieving understandability and reliability. Lack of order
and consistency is a prime source of software errors.
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Completeness, Sufficiency and Primitiveness
COMPLETENESS and SUFFICIENCY mean including all elements required for the solution,
and no unnecessary elements. PRIMITIVENESS entails preferring a simple solution to one
that is more sophisticated but also more difficult to understand.

Anticipating Change
Software is subject to changes, as a result of modifications in requirements or to correct
errors. The anticipation of change should be constantly kept in mind throughout stages
of design and construction.
One practical implication of anticipating change is the attempt to isolate the parts which
are expected to change, and possibly avoiding hard-coding such parts.
For example. the ink in a ballpoint pen is expected to run out. Consequently, the ink
holder is constructed as a separate part of the pen.
Another example: In a certain system several delays, with a value of 3, were added to
ensure that analog readings had stabilized before using them to trigger other events.
When the system was put to action, it appeared that in some cases this delay was
insufficient. Since the delay had been hard-coded as a number (3), it was required to
open the control software in order to modify it. In a different application, this delay
would be defined as a parameter, allowing the operator to modify it.
Parameters in general are a good way of anticipating change and also improve the code
understandability (numbers have names, which explain their nature).
Another example would be an on-off valve which opens when a command is sent to it.
Sometimes, a normally open (or fail open) valve is used, meaning that when a
command is sent to it the valve closes instead of opens.
Using only one control block in the software for both valves, with a parameter to switch
between the normal position: open/close—and respectively invert the command—is an
example a design that expects change.
There are two other benefits of this approach:
• You only have to maintain one block for two valves
• As such, you thereby increase the reliability of your code

Principles of Software Engineering: Exercise
To complete this section, we offer you a nice exercise in Principles of Software
Engineering (page 35). Match the principle name in the left column to the correct
description in the middle column and an appropriate example in the right column.
Write down the numbers you get and compare them to the answers on page 36.
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Tip:
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Table 1: Principles of Software Engineering

Principle

Description

Example

1. Separation of Interface and
Implementation

1. Hiding details that are not
part of the current level of
abstraction

1. One is more likely to say “excuse me, may I
borrow a pen” than to say “excuse me, may I
borrow a blue ballpoint pen?”

2. Information Hiding

2. A structure made of
separate components

2. The old spring-loaded mechanism of a clock
may be replaced with a modern batteryoperated one, and the hands will continue to
function as before.

3. Abstraction

3. Independence of interface 3. From looking at the hands of a clock, it is
and implementation
possible to tell the time, but not to know how
the hands “know” the time.

4. Modularity

4. Referring to essential details 4. Every battery-operated clock has means of
and ignoring non-essential
replacing its battery.
details, based on context

5. Uniformity

5. Concentrating related
5. In a digital alarm clock, the button that sets the
things at the same location
waking hour is adjacent to the button that sets
the waking minute.

6. Completeness

6. Anticipating and isolating
the parts that change

6. In all analog clocks, the short hand is the one
showing the hour.

7. Localization

7. Including all necessary
elements

7. Analog clocks have at least two hands: one for
the hour and one for the minute.

8. Sufficiency

8. Avoiding unnecessary
variations

8. Most retractable pens use the good old button
and spring mechanism to retract the pen

9. Primitiveness

9. Preferring a simple solution 9. Digital alarm clocks usually have no seconds
that is easily understood
display, because it is usually unnecessary.

10.Anticipating Change

10.Including only necessary
elements
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10.A computer may be quickly assembled
according to customer’s requirements regarding
CPU, memory, hard-disk, etc.
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Correct Answers:
1-3-2
2-1-3
3-4-1
4-2-10
5-8-6
6-7-7
7-5-5
8-10-9
9-9-8
10-6-4

The Process of Software Design
The following section reviews the parts of software design in a CLASSIC CODING PROCESS,
where design requirements are translated into a sketch of the final software. In this
design stage, this is often done on a piece of paper. This sketch, where the general idea
has been defined, is then translated in to code by a programmer.
Note that in WonderLogix Studio these stages are united into one, as the platform
allows graphical design of the control software, which can be easily “played with” and
modified—and later the implementation (coding) is done automatically without
requiring additional effort or decisions of how to implement. Nevertheless, we
recommend reading the following theoretical section, as it includes very useful ideas
and tips for good design that can be implemented also using WonderLogix Studio.

Software Design
SOFTWARE DESIGN is a process in which the internal structure of the program is
established. This is done by dividing it into different components, organizing them, and
establishing the connection between them. Software design is done after the software
requirements have been set (this is the previous stage in the process of software
development, and it is usually not performed by the control engineer) and precedes
software construction.
The importance of software design cannot be stressed enough. There are many who
begin coding immediately upon receiving a task. This approach is highly undesirable,
for the design process must be performed well before coding begins. A good design
significantly shortens the construction stage, and significantly improves the quality of
the program. In order to design the software, one must, of course, be well acquainted
with the software requirements.
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Large programs include a huge number of states. Lacking proper design, a large program
runs the risk of quickly becoming highly complex and not conforming to software
engineering goals: they are difficult to understand, change, and repair, and they tend to
have an increased chance of failure. Object Oriented Design was developed in order to
cope with this problem.
Using this method, software is made out of objects, that is, small and relatively
independent software components. Since the objects are smaller than the entire
program, they are much easier to handle. When these objects interact with each other,
they build the entire program. Furthermore, this process can be nested, meaning that
each object is, in turn, built of other interacting objects. Additionally, object oriented
design allows building solutions which better represent the real world, thereby helping to achieve
software engineering goals.
The process of object-oriented design includes the following stages:
1. Identifying each object
2. Determining the functionality of each object
3. Establishing the scope of each object
4. Determining the interface for each object
5. Implementing each object
After these stages have been completed, the objects may then be implemented.

Identifying Each Object and its Properties
The first step of the software design process—identifying objects and their properties—
involves examining the problem while trying to identify which distinct entities it
features. For this purpose, preparing a description of the problem that is as accurate as
possible is required. A simple (informal) way of identifying objects is listing the nouns
at the verbal description of the problem, and using that list to derive objects.
At this stage, it is important to identify the following:
• Objects with identical functionality, which should be represented as different
instances of a single class
• Objects with similar functionality, which may still be represented as different
instances of a single general class, featuring a differentiating property
A balance must be found between having many classes with relatively minor differences
between their instances, and having few classes with more marked differences between
their instances.

Exercise:
A certain system includes ten tanks. All tanks include a filling valve, a draining valve,
and a level transmitter for control purposes. Five of the tanks are stirring tanks (with a
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stirrer), two for slow stirring and three for fast stirring. The other five tanks are heating
tanks (including a heater and a temperature transmitter), two for low temperature and
three for high temperature.
How many classes should be created to represent the tanks?
• One
• Two
• Four
• Ten

Solution:
Two classes should be created to represent the tanks: a stirring tank class and a heating
tank class. This is the most useful level of abstraction, because it captures the most
important distinction, which is the purpose of the tank (a different purpose entails
different properties and actions, meaning that the differences are significant).
At the higher level, where a single class represents all kinds of tanks, this distinction
will be lost, as a single class is used to represent tanks with different purposes. At the
lower level of abstraction—four classes, one for each type of tank—there will be too
many classes with minor differences that will draw attention from that distinction.
In many cases, there exist HIERARCHICAL RELATIONSHIPS between objects. These relations
are commonly grouped into two distinct types:
• Composition relationship
• Inheritance relationship
The COMPOSITION RELATIONSHIP, (has-a), is one in which an object is made out of other
objects. For example: a car has a motor. This relationship is usually derived from a
composition within the actual space of the represented problem.
In order to identify a composition relationship between two objects, one should ask:
• Is object A a complete and functioning object independent of object B?
• Is object B a complete and functioning object independent of object A?
If the answer to both questions is identical (be it affirmative or negative), there is in all
likelihood no hierarchical relationship—and specifically no composition relationship—
between the objects. Otherwise (let us assume object A is not complete and functioning
independent of object B), object A might be composed of object B (and possibly other
objects). The main exception is when object B is being used not only by object A, but by
other objects, meaning it may not be considered a part of object A.
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Question:
In the system that was previously described, is there a composition relationship
between a tank and its level transmitter?

Answer:
Let us look at the guiding question: is a tank a complete and functioning object
independent of its level transmitter? The answer is no; as was previously stated, the
level transmitter is vital for control purpose. Is the level transmitter a complete and
functioning object without the tank? The answer is yes; the existence of the level
transmitter is independent of the tank and it may measure level wherever it is installed.
Therefore it is possible (and, indeed, logical) that a tank is composed of among other
things, a level transmitter.
The INHERITANCE RELATIONSHIP, (is-a), is a powerful relationship and requires very
delicate care. It is not supported by most PLCs (including Logix5000 controllers), so it
is not elaborated here.

Determining the Actions Related Each Object
At this stage, each object is examined with the purpose of determining which actions, or
what functionality, is related to it. A simple (informal) way of identifying actions is
listing the verbs in the verbal description of the object, and using that list to derive
actions. At this stage we are looking at the object from an external point of view,
without going into the details of its implementation.

Exercise:
Provide examples for actions related to each tank.

Answer:
The actions related to the tanks are not mentioned in the text, but they likely include
filling and emptying the tanks, stirring in stirring tanks and heating to a certain
temperature in heating tanks.

Determining the Scope of Each Object
The scope of an object is the set of all other objects that are available to it. Notice that if
object A is available to object B, it does not necessarily follow that object B is available
to object A. In object-oriented programming, the scope of each object should ideally be
as narrow as possible, meaning that potential connections between objects are kept to a
minimum. This serves to reduce coupling between objects, as required by the principle
of modularity.
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In order to identify the scope of an object, it is helpful to, first, picture the information
that passes between objects (sent from one object and received by the other) as electric
signals on wires, and then ask the question: when a signal leaves an object, should that
object know where the wire is going? If so, then the object into which the signal goes
should be in the scope of the object that sends the signal. If the object does not need to
know into which object the signal goes, then it is not within that object’s scope.
Similarly, when a signal goes into an object, should that object know the origin of the
wire? If so, then the object out of which the signal goes should be within the scope of
the object that receives the signal. If the object does not need to know the wire’s origin,
it is not within that object’s scope.

Exercise:
Is the tank within the scope of the level transmitter? Is the level transmitter within the
scope of the tank?

Solution:
Let us use the guiding question:
The level transmitter sends a signal to the tank (the measured level). Should the level
transmitter know where the signal ends up? No. This has no impact on the working of
the level transmitter. The level transmitter will function properly—that is, will measure
the level of the liquid within the tank—even if the signal should erroneously end up in
another tank. Therefore, the tank is not within the scope of the level transmitter.
The tank receives a signal from the level transmitter (the measured level). Should the
tank know where that signal is coming from? Yes. The signal is meaningless unless it is
known from which level transmitter it originates. The tank will not function properly if
the signal should erroneously come from another level transmitter. The level transmitter
is therefore within the scope of the tank.
Dividing the objects to different levels in the hierarchy, and consequently defining their
scopes, is a trade-off between the ease of understanding the model (the program) and
the availability of signals.
Let’s explain: An object is exposed only to other objects in its scope. That means that it
can only receive signals from, and send signals to, objects in its scope. If this is the case,
then why not put all the objects together in one scope and enjoy full accessibility to all
the signals? The reason is that, when all the objects are together, there is no hierarchy:
no sub-systems that help us understand the model and break down its complexity into
small pieces. This is the case with normal “flat” PLC code. On the other hand, if we
isolate the objects too much in many sub systems, most of the signals will be
inaccessible, and we’d need to chain them through many objects until they get to the
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object that needs them. This might be tedious—as well and affect the understandability
of the model.

Determining the Interface for Each Object
To better understand interface let’s begin with an example. A simple analog clock has
hands that show the time and a knob that is used to set the clock. The connection of
such a clock with the outside world (in this case, the user) is done in two ways only:
• The clock shows the user the time by moving its hands
• The user sets the clock by turning the knob
There are no other actions the clock can perform, and no other actions that can be
performed on the clock.
Two things should be noted:
• The relationship between the clock and the user is directional: showing the time is
done by the clock to the user; setting the time is done by the user to the clock.
• Moving the hands, whether it is to show the time or due to the knob being turned, is
an action that is always done by the clock mechanism.
This is an example of an interface. The interface includes the parts of the object that are
exposed to the outside world, and allow the object and the outside world to interact (in
our example, hands and setting knob). This relationship with the outside world can be
one of the following:
• Input: the outside world activates or updates the object (in our example, the setting
button)
• Output: the object activates or updates the outside world (in our example, the hands)
Note:

Some implementations of object-oriented design also allow a third type of
interface, Input/Output, where the object and the outside world activate or
update each other. The objects in WonderLogix Studio have only the first two
types of interface signals: inputs and outputs.

In the above example, the knob is an input to the clock and the two hands are its
outputs.
The interface may be formally defined as the borderline between the internal side of the
object: its implementation—and its external side: the user.
One can also view the interface as a sort of a contract between the object and the user:
the user is obligated to use only the interface to interact with the object, whereas the
object is obligated to behave as declared in its interface.
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Exercise:
Is the following interface acceptable for the stirring tank?
Inputs: fill tank, empty tank, stir
Outputs: tank is full, tank is empty, malfunction
Select the best answer:
1. No, because the classification of inputs and outputs is incorrect.
2. No, because it does not allow direct access to the valves.
3. Yes, because it allows using the tank and obtaining information from the tank.
4. Yes, because it provides all possible information from the tank.

Answers
3. Correct
4. Wrong
The purpose of the interface is to provide information from the tank, but also to
allow using the tank. Moreover, it is not required that all information from the tank
be provided. In our example, the tank level is not provided (probably due to lack of
relevance), but is used to derive two outputs: tank is empty and tank is full.
2. Wrong
Preventing direct access to the valves supports the SEPARATION OF INTERFACE and
IMPLEMENTATION. For example, if the filling valve is replaced by two filling valves,
the interface can remain unchanged, and the only changes made will be to the
implementation of the filling action: from opening a single valve to opening both
valves.
Furthermore, if actions defined in the interface are merely redirected to components
of the object (i.e. open filling valve) the object loses, so to speak, its ability to
perform actions at a higher level of abstraction. The action fill tank, for example, can
open the filling valve, wait until the level transmitter indicates a certain level, and
then close the valve.

Implementing Each Object
After the design stage, the objects are implemented by determining their mode of
representation and implementing the interface that was defined at the earlier stage. Each
object may be implemented in two ways:
• Top-down: Implementing the object using sub-objects before they themselves are
implemented (although they already have a well-defined interface)
• Bottom-up: Implementing the object using sub-objects that are already implemented
Both methods may be used in conjunction.
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DOCUMENTATION is an emphatically important part of the implementation. If the object
lacks documentation, especially interface documentation, many of the advantages of
object-oriented programming are lost: the user is forced to look at the implementation
in order to understand what the object performs and how it can be used, thus violating
the principles of ABSTRACTION and INFORMATION HIDING. Even if the programmer is the
only one who ever uses that particular object, experience shows that it is not long
before he or she requires documentation as much as any other user who is not
acquainted with the object.
The documentation of each object should include the following parts:
• General: The thing it represents (short verbal description), mode of representation
(see below) and the objects of which it is composed (if any)
• Interface: Ordered by inputs, outputs and inputs/outputs; each is described along
with its meaning or the action it performs, how it should be used and whether any
constraints or conditions on its use apply
• Implementation: It is recommended to include a general description of the manner
in which the object is implemented. Documenting the implementation is not likely
to be of any use to the user, who needs to use the object only through the interface,
but it expedites making changes to the objects when needed.
Note that the above-mentioned documentation of objects in the software is also a part of
the classic way of coding, where the code is hard to understand and requires much
explanation. For designs made using WonderLogix Studio, most objects are selfexplanatory thanks to the use of English words for object names and their interface
signals. The logic according to which the object (component) behaves is also written in
English sentences, a thing that makes most free-text documentation redundant and even
dangerous, if it is to be kept up to date.
However, it is recommended to add a short description for the objects (components) and
their parameters, which are usually manipulated by the end-user. A good tradeoff
would be to give a short description of an object and how to use it, but not describe
how its internal logic works, as the latter may change during the design process, leaving
the description outdated and misleading.
As for the practice of writing the documentation, here WonderLogix Studio saves a
significant amount of work and effort, since all the documentation is generated
automatically out of the model.
Having reviewed the process of classic software design, which is later supposed to be
translated to code by a programmer, we now recommend that you to move to the next
part of this User Guide and start learning the practice of using WonderLogix Studio.
This eventually will enable you easily make good and safe designs and translate them to
a ready-to-run code with a click of a button!
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Learning How to Use WonderLogix Studio
We have prepared a series of exercises to introduce you to the concepts behind
WonderLogix Studio. As a new concept or functionality is introduced a detailed stepby-step is given. In subsequent exercises, when that same concept or functionality is
needed, it is not accompanied by that same detailed explanation but rather a link if you
are unsure of how it is to be done.
We recommend that you build the project along with the exercise so that you begin to
understand how WonderLogix Studio works.
The exercises do not represent the only way to build a particular system, or even
necessarily the best way. They are designed to transmit the information logically and
clearly.
They also demonstrate best practices, which, in this case, means designing components
and systems that are generic and non-specific so they can be reused, with little
modification, elsewhere in the same project or in other projects.
Of course, no series of exercises can demonstrate solutions for every system that you
want to control by a PLC. You know your system better than anyone else. WonderLogix
Studio just gives you the tools to design it and control it.
So, as you progress, feel free to experiment, to try out alternate solutions to the ones
described in the exercise. Nothing you create in WonderLogix Studio is hard-wired. You
can modify, delete, move, and duplicate anything, until you are satisfied that the system
works for you.
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Exercise 1: Lubrication System
For this exercise we will guide you through the process of controlling a lubrication
system for a critical piece of equipment, such as oil circulation for bearings.
In this system oil is pumped from an oil tank to the consumers and then returns to the
tank by gravity.
The block diagram below describes such a system.
Figure 11: Lubrication System Block Diagram
Pump
P-100B

FSL
FSL
100B

To Consumers

From Consumers

T-108

LT
100

LT

Oil Tank

For this system you will require the following components:
• Oil tank with a level transmitter
• Oil pump
• Flow-switch-low on the pump discharge (triggered if flow is not detected)
You will design the system with the following functionality:
• Enabling the lubrication system turns on the pump.
• The pump is turned off if the oil tank level falls below 20%.
• The lubrication system reports a failure when pump is requested to operate for at
least three seconds and the flow switch indicates low flow.
Tip:

This project might easily be used, with some modifications, for any system that
moves a fluid substance to and from a reservoir: fuel, water, beer.
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The first step is to create a new project called Lubrication System. See Installing,
Activating, and Creating Your First Project. on page 11 for more information.
Figure 12: New Lubrication System

Create Lubrication System Structure
The structure of the Lubrication System, or of any system being designed in WonderLogix
Studio, comprises its components and the sub-systems in which they are located.
The following components are included in the specifications of this project.
• Oil tank with a level transmitter
• Oil pump
• Flow-switch-low on the pump discharge
You will notice that there are only three controlled or measurement devices: a level
transmitter, an oil pump and a flow switch. These physical devices send or receive
signals from the control system. In WonderLogix Studio, they are modeled as PHYSICAL
COMPONENTS. Physical components are the leaves of the hierarchical tree and can have
no sub-components. See Component Types on page 106 for more information.
The oil tank is not a part of the control system. It is a passive piece of equipment.
However, it is modeled as a LOGICAL COMPONENT containing the physical level
transmitter. Logical components are useful to help you visualize the structure of the
system. In this case, it provides context for the level transmitter. In addition, the use of
another hierarchical level helps simplifying the signals, as you'll see in a minute.

48

support@wonderlogix.com • 1-855-WLOGX5

Create Lubrication System Structure

Flow Switch Low Component
The first component to create for the lubrication system is a flow switch: a physical
component in the system that can be in one of two states—on or off—and can report
this state to the control system.
Figure 13: Create Flow Switch Low

(1)

(2)

(3)
1. Click the + at the bottom of the Current Component pane to open the CREATE NEW
COMPONENT window and add the flow switch to your system.
2. Type a descriptive name, in this case, Flow Switch Low, for the new component, in the
Component name field.
3. Click the Physical checkbox to indicate that the pump is a physical component and
represents a real device. Then click CREATE.
Figure 14: Flow Switch Low Component

WonderLogix Studio User Guide

49

Exercise 1: Lubrication System

The Flow Switch Low component you have created appears as a child, or a subcomponent, of the Lubrication System. The purple background and the wrench icon
indicate that it is a physical component.
In order for Flow Switch Low to communicate an on/off state to its surrounding, it
requires an output. This is done by adding an attribute to the component.
Figure 15: Add Output to Flow Switch Low

(1)

(2)

1. Click + on the right of the Flow Switch Low component to add an attribute for
output.
2. Type a name for the attribute to indicate the on/off attribute. We recommend calling
this attribute Active.
Note:

The Active output represents the wire coming out of the flow switch towards the
control system. So, while it is an output of the device, it is in fact a physical
input to the control system.

Tip:

Active is a good name because it is generic, and can therefore be used to
indicate any boolean output. This makes this component reusable for other
applications within this project or for others, such as pressure gauge,
temperature switch, or even a button.

Pump Component
Now create another physical component for the lubrication system: a pump. Unlike the
Flow Switch Low component, which is a measuring device, a pump receives input, an
electric voltage, to begin operation.
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As an alternative to the method described above, create this new component using the
context menu. Right-click the central area and select Add Component from the menu.
When this is done let’s enhance the Pump component by giving it a tag. For systems that
may have many pumps, a tag helps you identify parts of the system.
Figure 16: Add Tag to Pump Component

(1)

(2)

1. Bring your cursor to the Pump component and hover it over the name. A blue
information window pops up and the pointer becomes an I-beam cursor. Doubleclick.
2. Type the identification information for the Pump component, P1008, in the Tag area
and click Save.
In order for the Pump to receive instructions from the control system, it requires an
input. This is done by adding an attribute to the component.
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Figure 17: Add Input to Pump

(1)

(2)

1. Click + on the left of the Pump component to add an attribute for input.
2. Type a name for the attribute to indicate the input from the system. We recommend
active verbs for all inputs that describe commands. In this case call this attribute
Operate.
Note:

The same inversion that applied for outputs of physical components applies for
their inputs. While this attribute is an input of the Pump component, it functions
as a physical output for the controller system.

Now, assume that this pump has feedback: an output telling the control system that the
pump is receiving power. Add this output to the Pump component as an attribute to
indicate that it is receiving power and that is is on.
Tip:
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See Add Output to Flow Switch Low (page 50) if you need a reminder for this
procedure. Remember to use a good generic name, such as On.
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Figure 18: Flow Switch Low and Pump Components Complete

Pump Unit Module
At this point there remains only one additional physical component to create—a level
transmitter—and then you can create the logic that will make it all work.
However, the two components you created work together, as a unit. They share a
common function, and considering them as a group, or a MODULE, provides a logical
structure that makes it easier to build and to understand the model of the system.
Moreover, if the system you are modeling has an additional pump and flow switch, it
becomes more complicated to build the logic between all of the separate components.
Using modules in your design allows you to break down complexity into small,
manageable pieces and reuse repeating parts.
So what is the shared function of the pump and flow switch? Remember that the
Lubrication System’s role is to provide oil to critical equipment. The pump operates
when it is supplied with power, but if the flow of oil stops for any reason—a pipe
leaks, a pump shaft breaks—then an indication of the interrupted oil flow is required.
Flow Switch Low provides this indication by sending an Active signal when the flow is
low. Low flow is expected when the pump is not operating, but it indicates a problem
when the pump is operating.
All together, the Pump Unit module receives an Operate input to turn on the pump, and
reports back, through an output, when the pump is operating but the flow is low.
So, since they work together, let’s create a pump unit module.
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Figure 19: Pump Unit Module

First create a new component for the module. Call it Pump Unit and remember that it is
not a physical component.
Tip:
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See Create Flow Switch Low on page 49 for more information about creating
components.
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Figure 20: Lower Component into Module

(1)

(2)

(3)

Now that you’ve created the Pump Unit module it’s time to put the two physical
components you’ve created into it.
1. Right-click the Flow Switch Low component and select Lower from the context menu.
2. The Lower window displays one option for Select new parent: the Pump Unit module
you have just created. Click OK.
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Note:

In more complex systems you may have many different available modules in this
list.

3. As an alternative to using the context window, drag the Pump component into the
Pump Unit module. As you continue working with WonderLogix Studio you may
prefer one, or the other technique, to lower a CHILD into a PARENT.
Your Lubrication Project now consists of a Pump Unit module containing two physical
components: Pump and Flow Switch Low.

Oil Tank Module
The Pump Unit module you just completed was built from the bottom up: first you
created the physical components, then the module, and then lowered the components
into it.
We recommend, however, that you work from the top down. Because a complex system
may consist of dozens of interacting sub-systems, it is easier to approach the design by
considering, first, the big picture. Consider it like preparing a high-level block diagram.
Once this is in place you can begin inserting the relevant physical components, creating
the system interface, and building all of the logical connections.
So, by using the recommended practice, let’s build the Oil Tank module.

56

support@wonderlogix.com • 1-855-WLOGX5

Create Lubrication System Structure

Figure 21: Create Component in Module

(1)

(2)

(3)

1. In the Lubrication System create a new module, called Oil Tank and double-click it.
See Pump Unit Module on page 54 for more information on creating a module.
2. Zoom into the Oil Tank module and then create a physical component called Level
Transmitter. See Pump Component on page 50 for more information about creating
physical components.
3. Add an output to the Level Transmitter called Reading. Unlike a switch, which can be
either on or off, a transmitter measures an analog value, and provides a reading, or
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value, to the control system. (Reading or Value are acceptable names for this attribute.)
Click the Zoom Out icon to exit the Oil Tank module. See Add Output to Flow Switch
Low on page 50 for more information about adding an output to a physical
component.
When you are done your model will look like the figure below.
Figure 22: Two Modules Complete
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Create Lubrication System Interface
When examining the model you’ve created, consider what you want to ask it to do, and
what information you want it to report to the outside world.
In this case, we assume that this lubrication system will be planted in a bigger control
system, providing it an Enable signal and receiving from it a Failure indication.
So, let’s review the original specifications of the lubrication system,
• Enabling the lubrication system turns on the pump.
• The pump is turned off if the oil tank level falls below 20%.
• The lubrication system reports a failure when pump is requested to operate for at
least three seconds and the flow switch indicates low flow.
Figure 23: Lubrication System Interface

(1)
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1. First, an enable input is required to allow a higher hierarchy module (a future
parent of the Lubrication System) to Enable it. Add an attribute to the Lubrication
System and give it the name Enable. See Add Input to Pump on page 52 for more
information about adding an input to a component.
Note:

When the input is an active command to the component, it is best to name
input attributes in the form of an active verb (Enable, Start, Stop) rather than a
description of the final state (Enabled, Started, Stopped). Other inputs are not
commands, but information, such as Tank Full, Alert On, or Last Pump.
The system logic is built using natural language, and the use of the proper form
makes the logic clear.

2. When the Lubrication System receives the Enable command, it directs the pump to
operate. So now add an attribute to the Pump Unit and give it the name Operate.
3. Now look at the Oil Tank. It receives no input from the system because it is a passive
component, as we mentioned before. It includes, however the Level Transmitter.
Besides improving the understandability of the model by locating the Level
Transmitter as a sub-component of the Oil Tank, it also allows simplification of the
Level Transmitter signal: a transmitter creates an analog signal, which is a precise
value in a certain range. However, the Pump Unit only needs to know if the level is
OK for operation. By adding a simple Level OKoutput to the Oil Tank you can let the
Pump Unit refer to it. The Oil Tank internally decides if the level is OK by referring
to the analog measurement.
So now add an output attribute called Level OK to the Oil Tank.
4. Now consider the Pump Unit. If the oil level is low, or there is some other problem
that prevents its operation, it should report this situation. So add an output attribute
with the name of Failure.
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Create Lubrication System Logic
Now that the interface is complete, we use the logic editor to tie it all together.
Review the functionality defined for the lubrication system.
• Enabling the lubrication system turns on the pump.
• The pump is turned off if the oil tank level falls below 20%.
• The lubrication system reports a failure when pump is requested to operate for at
least three seconds and the flow switch indicates low flow.

Pump Unit Operate Logic
The first step is to define pump unit operation logic. According to the functionality
defined for the lubrication system, when the lubrication system is enabled the pump is
activated as long as the oil level is OK.
Let's think of this sentence differently, and try to summarize all the conditions for
operating the pump:
• Enable of the Lubrication System
and
• Oil Level in the Oil Tank is OK.
Now we can open the Logic Editor on the Operate input attribute of the Pump Unit
module and create this logic.
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Figure 24: Pump Unit Operate Logic

(1)

(2)
(3)
(4)
(5)

(6)
(7)

(8)

(9)

(B)

(A)

1. Right-click the Operate attribute of the Pump Unit and select Logic Editor from the
context menu.
2. Choose the most appropriate phrase from the options presented by the Logic Editor at
the bottom of the screen. In this case, the Boolean option: “Operate Pump Unit only
while…” is the right one. The other sentence tries to make Operate equal to a
number, which doesn't make sense, since Operate can only be on or off (0 or 1).
Click the green continue button of the first sentence to present the possible triggers
for this action.
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3. The appropriate continuation of the sentence is the boolean option: “Operate Pump
Unit only while Lubrication System receives Enable…“ Click the green continue button.
4. At this point the logic is valid, but it covers only one condition of the required
functionality. According the specifications the oil level must be OK. So open the
And/Or dropdown
5. and select And.
6. Notice how the sentence structure changes to: “Operate Pump Unit only while all of the
following are met.” The first condition is copied. To complete the second condition
first change the displayed component from Lubrication System
7. to Oil Tank.
8. Click the green continue button after the boolean option to add the appropriate
phrase to the logic sentence: “Oil Tank reports Level OK…
9. Click the checkmark to accept the completed logic for the Operate attribute of the
Pump Unit.
The completed logic sentence appears in the Logic Editor area. At a later time you may
edit the sentence (A) or delete it (B), using these buttons.
Note:

The logic sentence also appears when you hover over the Operate input attribute of
the Pump Unit.

Pump Unit Logic
You have now completed the big picture for the Pump Unit module: when, and under
what conditions, it operates.
However, remember that the Pump Unit module is a logical component. For the system
to work we must connect the logic to the physical components inside the module.
First, double-click the Pump Unit module to view the components it comprises.
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Figure 25: Pump Unit Logic

(1)
(2)
(3)
(4)
(5)
(6)

(7)
(8)
(9)
1. Notice that the Activate input of the Pump depends solely on the Operate input of
the Pump Unit. In other words, they could be connected by a wire, making them
always equal to one another. In this case a shortcut is available as an alternative to
opening the Logic Editor with a double-click, as you did before. Hover your mouse
over the arrow from Operate and then drag it to Activate.
2. The Logic Editor opens with the only available option: “Activate Pump only while Pump
Unit receives Operate.” Click the Checkmark button.
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Now create the logic for Pump Unit failure. According to the specifications, the
system reports a failure when the pump is requested to operate for at least three
seconds and the flow switch indicates low flow. So the first step is to create logic for
the Failure output attribute. Double-click it.
3. Failure, as we’ve seen before, is a Boolean signal (true or false). Therefore, the first
sentence, marked by the 1/0 icon is the right one for it, so accept: “Pump Unit reports
Failure only while…”
4. Then accept the first option to build the sentence: “Pump Unit reports Failure only
while Pump Unit receives Operate…”
5. Now select and to add a condition.
By including “and” the logic sentence changes to “Pump Unit reports Failure only while
all of the following are met: Pump Unit receives Operate.”
6. Change the boolean option to read “Flow Switch Low is Active” and press the continue
button.
7. Now add the time constraint to the logic. Consider how the physical components
interact in such a system. Each one of the conditions can accept a time/count
constraint, and also the combination of them both, by opening the appropriate droplist at the end of each line.
What's the difference?
Two functionalities can be achieved:
• At startup, a delay is certainly required to prevent a false alarm until flow build
up.
• During operation, after the pump has been on for a while but suddenly there is
no flow, two functionalities can be achieved: wait for three seconds, or report a
failure immediately.
Placing the time constraint on the combined conditions (after all of the following),
would result in the former behavior.
Placing the time constraint on the condition Pump Unit receives Operate only, would
result in the latter behavior. The reason behind it is that losing flow in the middle
of operation is not reasonable, and the ciritical equipment must be informed of the
failure immediately. The best place to check for a delay in oil supply is the pump.
8. Add “Pump Unit reports Failure only while all of the following are met: Pump Unit
receives Operate for a consecutive time of 3.0 seconds and Flow Switch Low is Active.”
9. Press the Check button to accept the logic construction.
Now zoom out of the Pump Unit module to return to the Lubrication System.
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Oil Tank Logic
Zoom into the Oil Tank module to set up its logical function.
Figure 26: Oil Tank Logic

(1)

(2)

1. Open the Logic Editor to set up the logic for the Level OK attribute.
2. The Logic Editor opens up a single boolean option: “Oil Tank reports Level OK only
while…” Add an analog trigger for the reading of the Level Transmitter by setting a
value of 20.
Accept the complete logic sentence and zoom out of the Oil Tank module.

Lubrication System Failure Logic
Now what remains is to make a logical connection between the failure of the Pump Unit
and the failure of the Lubrication System.
1. Open the Logic Editor on the Failure attribute of the Lubrication System.
2. Modify the logic sentence to “Lubrication System reports Failure only while Pump Unit
reports Failure” and press the checkmark button to accept it.
You have now completed the Lubrication System. You can now generate code for your
Studio 5000 system (how does this work?)
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Lubrication System Change Order 1
The beauty of WonderLogix Studio is the ease with which you can make changes to
your original model based on experience or new considerations in the system. Rather
than dive deep into code to tweak it, you can change the model and generation new
code.
As the current system is designed, it fails in the event that there is more than a three
second delay in oil flow. In order to increase the reliability of the lubrication system
let’s add a backup pump unit that will kick in when the main pump system reports
failure. The modified lubrication system will report failure only if both the main pump
unit and backup pump unit report failure.
The first step in implementing this change order into the WonderLogix Studio model is
to create a second pump unit, which is basically identical to the first.
Of course you can right-click the Pump Unit module and select Copy from the context
menu, but we recommend, instead, creating a Pump Unit CLASS. With two pump units in
this system, any change in the functionality of copied components must be made in all
of them, one by one. However, changes made to a class are reflected in all instances of
that class.
While working with WonderLogix Studio always think how the modules and
components that you create can be reused elsewhere in you project, or in other projects.
See Component Class on page 107 for more information.
First open your Lubrication System project.
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Figure 27: Create Pump Unit Class

(1)

(2)

(3)

(5)

(4)

1. Right-click the Pump Unit module and select Create Class from the context menu.
2. Click the + button next to the new class you just created.
3. Give this second instance of the Pump Unit the name Backup Pump Unit and click
Create.
4. Now change the name of the first instance of the Pump Unit by double-clicking its
name.
5. Type Main Pump Unit in the Name section of the Component Properties pane and click
Save.
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Before continuing work on this model drag the Backup Pump Unit unit up under the
main pump.
Note:

The arrangement of modules and components has no functional impact on the
model. However, by grouping them together, you may find it easier to understand
the system.
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Figure 28: Pump Unit Class Complete

(1)

(2)

(3)

1. Begin to drag the Backup Pump Unit upward.
2. Drop the module when the gray bar appears below the Main Pump Unit.
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Note:

If you drop the component before you see the gray bar it will disappear—more
exactly, will be lowered—into the Oil Tank. Click Undo from the Edit menu
and try again.

In order to utilize the backup pump it must begin to operate if the main pump fails.
This requires a change to the system logic.
Instead of the failure of the Main Pump Unit triggering failure, change the logic so it
triggers Operate of the Backup Pump Unit.
Figure 29: Lubrication System Change Order 1 Logic

(1)

(2)
(3)
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1. Open the Logic Editor for the Backup Pump Unit.
2. Direct the Backup Pump Unit to operate when the Main Pump Unit reports failure.
3. Edit the Lubrication System output attribute Failure logic so that it reads “Lubrication
System reports Failure only while Backup Pump Unit reports Failure” and accept the change.
With that the modifications specified in the change order are complete.
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Lubrication System Change Order 2
One goal in creating models in WonderLogix Studio is to make them both flexible and
understandable. This helps not only in the current project but also for reusing
components of the system as classes that can be reused in other systems.
So, for this reason, “hard-coded” analog values that are used in the Lubrication System,
such as the three-second delay that triggers pump failure, and the 20% volume set for
the oil tank minimum level, should usually be replaced by PARAMETERS, which offer
better understandability of the meaning behind this “magical number” as well as giving
the ability to change it easily and safely, including by the operator of the live system.
See Parameter on page 116 for more information.
First open your Lubrication System project and zoom into the Main Pump Unit module.
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Figure 30: Lubrication System Change Order 2

(1)

(2)
(3)
(4)
(5)

(6)

1. Click the + button in the Parameters area.
2. In the Create New Attribute window type Delay To Failure as the name for the
parameter. Click Create.
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Note:

We recommend that you always capitalize every word in parameter names.
When the Studio 5000 code is generated all spaces in names are deleted and
using this capitalization scheme (called upper camel case) makes understanding
the code easier.

3. Open the Logic Editor for the Failure output attribute of the Main Pump Unit output
attribute and click the Edit icon.
4. Click the Options drop-down for the time constraint value.
5. Change the current constant option to the parameter you just created: Delay to Failure.
Save the change.
6. The Delay to Failure parameter now appears with the default value of 0.0 seconds. To
change it to three seconds double-click the parameter name and change the initial
value to 3.0 and click Save.
Zoom out of the Main Pump Unit module.
Note:

Because you made this change in an instance of the Pump Unit class, the same
change has automatically been made in the Backup Pump Unit.

To complete change order 2 follow the same procedure to create a Minimal Level
parameter for the Level Low output parameter in the Oil Tank module.
The final logic sentence should read “Oil Tank reports Level Low only while Reading of Level
Transmitter is less than parameter Minimal Level.”
With this the modifications specified in the change order are complete.
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Lubrication System Change Order 3
In the model of the lubrication system you have created, the pump ceases operation
when the oil level is low.
In a real-world system you would expect that a failure of this type would be reported so
that, at minimum, the oil supply can be refreshed, or repairs made to any components
that may have failed.
Make this modification to the Lubrication System model by editing the relevant logic.
Tip:
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Take a look at the steps below if you get stuck.
1. Open the Logic Editor for the Lubrication System output attribute Failure.
2. Edit the logic sentence.
3. Insert an additional trigger by clicking and.
4. Modify the default sentence to “Oil Tank does not report Level OK.”
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Lubrication System Change Order 4
This change order reflects the kind of real-experience on the ground that may be
difficult to anticipate when a system is first designed.
The situation: The oil level drops below 20% and the pump ceases operation. However,
upon refilling the oil tank the pump immediately starts working when the level rises
above the minimum, and the level transmitter reports that the oil level is OK.
Because this poses a safety hazard, a new change order specifies the following
modifications:
• Eliminate the operation command to the pumps when there is a failure
• Latch the failure when it happens
• Require an external reset to continue operation

Lubrication System Failure State Properties
The first task is to make the operation of the Pump component dependent on the failure
state of the Lubrication System. However, it is not possible to refer to an output of a
component in the logic of one of its internal attributes.
The way to accomplish this task is to define a property, which is like an internal
variable. See Property on page 115 for more information.
First, open the Lubrication System.
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Figure 31: Lubrication System Failure State Properties

(1)

(2)
(3)

(4)

(5)
(6)
(7)
(8)
1.
2.
3.
4.
5.

Click the + icon in the Properties space in the right pane.
Type Failure State as the new attribute and click Create.
Open the Logic Editor of the Failure State attribute by clicking as shown.
Select the boolean option for the Failure State attribute.
Add the following conditions to “Lubrication System sets Failure State only while…”
• Pumping Unit reports Failure
• or
• Oil Tank does not report Level OK
Click OK.
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6. With this new property you can now simplify the Lubrication System failure logic.
Open the Logic Editor and delete the current logic sentence.
7. Build a new logic sentence by adding, to the default phrase “Lubrication System
reports Failure only while…,” “property Failure State is set” and click OK.
8. Now edit the logic of the Operate input attribute of the Main Pump Unit. Instead of
using the output attribute of the Oil Tank use the Failure State property. Create the
following sentence: “Operate Main Pump Unit only while all of the following are met:
Lubrication System receives Enable and property Failure State is not set” and then click OK.

Lubrication System Operation Latch
The second requirement of the change order to prevent the pump from operating until
it is reset: to latch or unlatch the system.
Figure 32: Lubrication System Operation Latch

(1)

(2)

(3)

(4)

(5)
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1. Create a new input attribute for the Lubrication System called Reset.
2. Launch the Logic Editor for the Failure State property so you can edit it.
3. Change the first part of the logic sentence to “Lubrication System sets Failure State from the
moment any of the following is met” and click OK.
4. WonderLogix Studio immediately presents a hole in the logic you’ve just created. We
know how to set the failure state, or latch it. Now we need to define how to begin
operation again: to unlatch it. So change the logic sentence to “Lubrication Project clears
Failure State from the Moment Lubrication Project receives Reset” and click OK.
5. At this point WonderLogix Studio presents you with a conflict to resolve. What
happens if the system is reset but the oil level is below minimum? The suggested
sentence best fits the requirements: “In case of conflict Lubrication System sets Failure State.”
Click OK.
You have now completed this change order, and the exercise.
Well done!
Save your work.
We will refer to code and document generation at a later stage in this series of exercises.
Now, our goal is to concentrate on design.
If you are impatient, you can play by yourself with the options under the file menu.
See you in Exercise 2!
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In this exercise we will expand on the techniques and methods you have learned in
order to control a water supply system that includes a water tank supplied by a water
well.
The block diagram below describes the system.
Figure 33: Water Supply System Block Diagram
Water Tank
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Water Level

60

Level
Transmi! er

40

Water Well

Pumping System
A main pump and a
backup pump
pumping water from
the well
To Consumers
LSH
101

Water Level
Switch High

For this system you will require the following components:
• A water tank
• A water well consisting of
• A pumping system
• A water level switch high
You will design the system with the following functionality:
• Water is supplied to consumers at an unknown rate.
• Whenever the power is on, the control system is active.
• The water level in the tank is to be maintained between 40% and 60% by turning on
the pumping system.
As with any system design, think about components and modules that you have
previously created that can be used in this project. For example, the previous

81

Exercise 2: Water Supply System

lubrication system exercise includes a pumping system very similar to the one required
here. Making modifications to work you’ve already done is far easier than designing
from scratch. This is one of the most powerful concepts behind object-oriented design.
First launch WonderLogix Studio and create a new project called Water Supply System.
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Water Supply System Structure
As you can see from the block diagram, there are two modules in the Water Supply
System: a water tank and a water well. The water tank contains a pumping system
similar to the one you designed in Exercise 1.
First let’s create the two main modules by creating two sub-components and naming
them Water Tank and Water Well. When that’s done you can import the pump system you
created in the previous exercise into this project and place it inside the Water Well.
In the Water Supply System create the Water Tank and Water Well virtual components.
Figure 34: Water Tank Module in Water Supply System

Now open the Lubrication System project by clicking File > Open Project.
Note:

You may have multiple projects open at once. You can switch between them by
clicking them under View in the top menu.
WonderLogix Studio does not, however, support multiple instances of the
application.
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Figure 35: Export Lubrication System

(1)

(2)
(3)

1. Right-click any part of the Lubrication System and select Export from the context
menu.
2. In the EXPORT TO FILE menu type a generic name, such as Pumping System.
3. We recommend that you type a description for the file so it will be easier for you to
identify it when you use it for subsequent projects.
Click OK to open the Save As window. We recommend that you accept the default name,
file type, and folder location. You may, however, find it convenient to create subfolders within the default location.
Note:

The exported file is given a wso extension, which stands for WonderLogix Studio
Object. Project files have a wsp extension: WonderLogix Studio Project.

Click Save and then return to your Water Supply System using the View menu.
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Importing Pumping System Class
With Pumping System.wso created, let’s import it as a class into the Water Supply
System.
Figure 36: Importing Pumping Unit Class

(1)

(2)

(3)

1. Click the + button in the Classes zone and elect Pumping System.wso. Click
Open.
2. Click the + button next to Pumping System in the classes zone to add an instance to
the Water Well module.
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Note:

The exported Lubrication System included a class called Pump Unit that was
used in the Main Pump Unit and the Backup Pump Unit. The Pump Unit class
is included automatically.

Because this is not a pumping system for lubrication, the next step is to make some
changes so it applicable for a water well.
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Modifying the Pumping System Class Structure
As you modify the Pumping System class for use in a water well, pay particular attention
to components that may be of use elsewhere in the Water Supply System.
As you remove and add components to the Pumping System you may notice that you are
also creating errors in the original logic you built in Exercise 1. Instructions are given in
Correcting the Pumping System Class Logic (page 89) to fix these errors. However, feel free
to tackle this task yourself as you go along.
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Figure 37: Modifying the Pumping System Structure

(1)
(2)

(3)

(4)

(5)

(6)

(7)
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1. In Exercise 1, the reset functionality, which you added in Lubrication System
Operation Latch (page 79), is used to unlatch the Failure State invoked whenever the
pumps are in failure or the oil level is low and requires filling. In a water well, the
water may rise again above the minimal level, so we don't need to latch this failure
and require a reset. Instead we want it to start pumping again automatically. So,
right-click the arrow of the Reset output attribute and select Erase from the context
menu.
Note:

In some cases a latch-reset functionality for the pumps might be useful, but for
the sake of simplicity in this exercise we’ll delete it.

2. Because the pumping system is for well water and not lubrication oil, double-click
the name of the Oil Tank and change its name to Well Head.
3. Zoom into the Main Pump Unit.
4. According to the specifications, the Well Head module requires a Water Level Switch
High. Let’s make use of an existing switch, Flow Switch Low, which can easily be
modified for this purpose. Right-click the Flow Switch Low component, select Create
Class, and name it Switch.
Note:

Even though Flow Switch Low was included in your definition of the Pump
Unit class, in order to use it elsewhere in the system it must be defined as a
specific class.

5. Zoom out of the Main Pump Unit and zoom into the new Well Head module. The
existing Level Transmitter is not used for this module, but the water tank does use
one. So right-click the Level Transmitter and save it as a class called Transmitter.
6. Delete the Level Transmitter and the Minimal Level parameter.
7. Add an instance of the Switch class to the Well Head and give it the name Level Switch
High. Then give it the tag LSH 101.
When you are finished zoom all the way out to the Water Supply System to correct any
errors in the system logic.

Correcting the Pumping System Class Logic
Now it’s time to correct the errors in the logic of the Pumping System that were created
when the structure was modified, as well as connect the Pumping System to the Water
Well module.
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Figure 38: Correcting Pumping System Logic

(1)

(2)

(3)

(4)

(5)

(7)

(6)
1. Select File>Verify Model Logic to see logic errors in the model highlighted in red.
2. Errors were found appears against a red bar in the message area, and the project
component tree highlights, in red, elements with errors. Double click Pumping
System to zoom into that component.
3. Hover your mouse over the Enable attribute, which indicates No logic defined.
4. Now hover your mouse on the Failure State property to see the detailed logic and the
logic error indicated by red strike-through text. Double-click the red marker to
launch the Logic Editor.
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5. Since the latch reset functionality is no longer needed delete all the logic sentences
by clicking the trash bins.
The deleted logic is replaced with the sample “Pumping System sets Failure State
only while…” Modify it by setting two “only while” conditions:
• Backup Pump Unit is in Failure
(or)
• Well Head does not report Level OK
Once done, the Failure State property becomes gray as well, indicating that you have
solved the problem.
6. Now double-click into the Well Head module where the other logic problem exists.
Because the Level Transmitter component was removed, the Level OK logic must be
modified, as you can see when you hover over the Level OK output attribute. Open
the Logic Editor, change the current logic sentence to “Well Head reports Level OK only
while Level Switch High is Active” and click OK.
7. All logic errors should now have been resolved. Click the blue reset icon to close
Logic Verification mode.
Now we create the logical connection between the Pumping System and the Water Well.
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Figure 39: Water Well Attributes

(1)

(2)
(3)
(4)

1. First create two attributes for the Water Well: an input to operate it, and an output to
report failure.
Tip:

What’s the difference between Operate and Enable?
• Operate is a direct command to turn on something.
• Enable gives process conditions that allow the operation of a subsystem. This sub-system will have means to decide internally when
to operate. Sometimes it’s possible for a system to have both inputs:
Enable and Operate. Enable gives permissive conditions, and Operate
is the command. To operate the system, both inputs need to be On.
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2. Now zoom into the Water Well and connect its input/output attributes to the input
attributes of the Pumping System. Drag the arrowhead of the external Operate
attribute to the square marker of the Pumping System's Operate attribute.
Note:

Since the Pumping System is the only component in the Water Well, you may
consider it to be a redundant level of complexity. However, since additional
systems may be added alongside the Pumping System—such as, for example, a
filtration system—the Water Well is useful for flexible design.
Besides, we can take use this situation to learn something new:
whenever you need to connect inputs or outputs which are always
identical, you can just drag the arrowhead of the parent component to
parallel one in the sub-component.
Read the logic that pops up automatically. adjust as required (add
send…to or set…of) and approve. A wire is drawn every time you hover
over one of the inputs. It means that they are identical, and you don’t
even need to read the logic.

3. When the connection is made the Logic Editor opens. Click the check mark.
4. Do the same with the external and internal Failure attributes.
According to the model specifications, the pump is activated when filling is required.
Even though there is not yet a method to know when filling is required, we can still
build the logic needed to enable the Pumping System.
Figure 40: Filling Required Attribute

(1)

(2)
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1. Zoom out of the Water Well to the root component. Add an output to the Water
Tank - Filling Required.
Tip:

Note that the output is not defined as operate pump or something similar which
is out of the scope of the Water Tank. The module only knows what’s going on
internally. It knows that it need filling. It doesn't know how this filling is
provided. For example, at some point this filling request might be fulfilled by
opening a valve rather than turning on a pump.

2. Stand on the Operate input of the Water Well, launch the Logic Editor and build the
correct sentence.
Tip:

The correct sentence is Operate Pumping System only while Water Tank reports
Filling Required.

Now you can continue to the next section and create the internal parts of the Water
Tank.
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Water Tank Module
Zoom into the Water Tank, the second module in the Water Supply System.
Figure 41: Water Tank Module

(1)

(2)

(3)
(6)
(5)

(4)

1. Add an output attribute called Filling Required to the Water Tank module.
2. Zoom into the Water Tank module and insert an instance of the transmitter class,
calling it Level Transmitter, and giving it the tag LT 201.
3. Launch the Logic Editor for the Filling Required output attribute.
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Note:

The default connection between the action and the trigger is only-while.
However, in the case of an inconsistent range (set when lower than one value,
clear when higher than another value) two separate from the moment sentences
are required.

4. Build the logic sentence to read “Water Tank reports Filling Required from the moment
Reading of Level Transmitter is less than 40” and click the Continue button.
5. Because you selected “from the moment,” the logic requires a complementary
sentence about how to clear, or unlatch, the filling requirement. So complete this
sentence to read “Water Tank clears Filling Required from the moment Reading of Level
Transmitter is greater than 60” and then accept the sentence.
6. In every latch/unlatch logic construction WonderLogix Studio asks what to do in the
event of a conflict (when the conditions for both set and clear are met). Change the
logic sentence to In case of conflict Water Tank clears Filling Required and then save.
Note:

In this particular case, Filling Required relies on a level transmitter that reports a
single value, so there is no real possibility of conflict. In future releases of
WonderLogix Studio, this conflict resolver will not appear in such cases.
Nevertheless, it is recommended to choose the safe position.

Zoom out of the Water Tank. The Water Supply System is now complete.
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Water Supply System Change Order 1
This change order comes about because, after running the system, the level transmitter
occasionally gave unreliable readings, a situation which led to water overflowing from
the tower.
In order to accommodate for this level transmitter malfunction, a level switch is to be
added to report high level in the tank even when the level transmitter reading is
erroneous.
The block diagram below describes the changes to be made to the system.
Figure 42: Water Supply System Change Order 1 Block Diagram
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This change order includes the following improvements:
• Make the design more generic, understandable, and flexible by changing the numbers
to parameters.
• A level switch is to be added to report high level so that it can override the level
transmitter should this be necessary.
Both modifications refer to the Water Tank and its child components.

Filling Required Parameters
Zoom into the Water Tank module.
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Figure 43: Filling Required Parameters

(1)

(2)

(3)

(4)
(5)

(6)

1. Create a new parameter called “Minimal Level.” WonderLogix Studio recognizes it as
analog value and gives it an initial value of 0.0. Double-click it and change this value
to 40, as specified in the change order.
Note:

At this point it seems logical to create an additional parameter called “Maximal
Level” and use them both for improving the Filling Required logic. While this is
a perfectly functional design, in this exercise we will use an alternative method
based not on discrete numbers but rather an arithmetical difference.

2. To the Minimal Level parameter you have already created, add one called Level
Difference. Since the water tank should not go over 60, change the initial value of
Level Difference to 20.
3. Add a property called Maximal Level and open its Logic Editor.
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Tip:

PARAMETERS are constant numbers. They improve the understandability of the
design and can sometimes be modified by the user. However, they are constants
and cannot accept logic. PROPERTIES are internal variables that accept logic.
Their value changes at run time, hence they are not constants.

4. Toggle on Numeric Modification so arithmetical functions can be used in this logic
sentence.
5. In the analog option change Constant to parameter and then choose the Minimal Level
parameter you created earlier.
6. Select the plus operator. Then complete the logic sentence as follows: “Make Maximal
Level equal to parameter minimal Level plus parameter Level Difference always” and accept
the sentence.
To complete this part of the change order, change the Filling Required logic to use the
new Minimal Level parameter and Maximal Level property you have just defined.
Tip:

If you get stuck your final logic sentences should read like this:
• Water Tank reports Filling Required from the moment Reading of Level Transmitter
is less than parameter Minimal Level
• Water Tank clears Filling Required from the moment Reading of Level Transmitter is
greater than property Maximal Level
There is no change required for the conflict logic.

Level Switch High
The second part of this change order is to add a level switch to the water tank to make
sure that the water does not overflow in case the level transmitter malfunctions.
Try your hand at making these modifications yourself. When you are done compare it
to the solution laid out below.

Add Switch
1. Add an instance of the switch class to the water tank.
2. Call it Level Switch High.
3. Give it the tag name LSH-203.
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Change Filling Required Logic
Figure 44: Level Switch High Logic

(1)

(2)

(3)

(4)

1. Open the Logic Editor of the Filling Required output attribute.
2. Edit the logic sentence that clears Filling Required using the Maximal Level property.
Add or as shown, and complete the sentence with the phrase “Level Switch High is
Active” and accept the change.
Tip:
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You took care to stop pumping in case the level reaches the level switch. But it’s
also important to prevent starting of the pumping in case the level switch is
active.
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3. Edit the logic sentence that reports Filling Required using the Minimal Level property.
Add and as shown, and complete the sentence with the phrase “Level Switch High is not
Active” and accept the change.
4. For extra security, rearrange the logic sentences in the order shown in the figure
above.
Tip:

Although it does not effect performance, we always recommend rearranging the
from the moment triplet in the initial structure of:
1. Set (the positive action)
2. Clear
3. Conflict resolver
You can easily do this by dragging sentences up and down. It makes
reading and understanding of these logic sentences much easier.
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Water Supply System Change Order 2
A subsequent change order requests additional conditions for enabling the pumping
action, which will add a switch for operators to disable the system without unplugging
it, and a warning light to indicate failure in the pumping system.
The block diagram below describes the changes to be made to the system.
Figure 45: Water Supply System Change Order 2 Block Diagram
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The following components should be added:
• An operation switch (SW-001) to allow users to disable the pumping system without
unplugging the PLC
• An indication light (XL-002) to alert users of pumping system failure
Try your hand at making these modifications yourself. When you are done compare it
to the solution laid out in the sections below.
Tip:
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See if you can incorporate a property with the name Operation Conditions. Make
it dependent on the operation switch and the pumping system dependent on it.
This may look redundant now, but, because it is a more generic solution, it will
make it easier if, for example, a subsequent change order requests another
condition for enabling the pumping system.
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Operation Button
With the Water Supply System open do the following:
1. Insert an instance of the switch called Operation Switch.
2. Give it a tag name of SW-001.
3. Create a property called Operation Conditions.
4. Launch the Logic Editor for this new property and create this sentence: “Water Supply
System sets Operation Conditions only while Operation Switch is Active.”
5. Edit the Water Well logic by including an additional condition. The final sentence
should read:
Enable Pumping System only while all of the following are met:
• Water Tank reports Filling Required
• property Operation Conditions is set

Failure Light
With the Water Supply System open do the following:
1. Create a new physical component called Failure Light.
2. Give it a tag name of XL-002.
3. Add an input attribute called Illuminate.
4. Create logic for this attribute as follows: “Illuminate Failure Light only while Pumping
System reports Failure.”
This change order is now complete.
Congratulations for finishing Exercise 2.
In this exercise you learned to reuse an existing component—even though it was not
exactly what you needed—by importing it and making the required modifications. And
you are now better acquainted with properties and parameters.
We haven’t yet discussed code generation or exporting your model to a document.
Although these functions are easy to perform—check the File menu—we recommend
that you keep improving your design skills by using the following resources:
• Review the last two exercises
• Read through the User Guide, concentrating especially on features that haven’t yet
been discussed, such as arrays
• Check our resource page, https://wonderlogix.com/resources/) for additional exercises
that we publish from time to time
• And, most importantly, start working on your own models.
Keep following the technical materials and periodic educational webinars.
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Good luck,
The WonderLogix Team.
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Concepts
This section describes basic concepts and terms.

Model
WonderLogix Studio allows you to create

MODELS

of industrial control systems.

The model is a hierarchical structure of COMPONENTS (see below). It is a model of the
control system rather than the controlled system, although its structure typically reflects
that of the controlled system.
Each model is contained in a project that is saved in a .wsp (WonderLogix Studio
Project) file.
As with any model-based design solution, the model serves as a single source of data
from which several products can be derived, such as PLC code and functional specs. If
any of these products require modification, you should first modify the model in
WonderLogix Studio and then derive an updated product. We highly recommend that
you do not modify the products directly.

Component
A COMPONENT is the basic structure unit in the model. The entire model is built of
components in a tree structure—a single root component containing other components
which typically comprise additional contained components.
Figure 46: Pumping System
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The pumping system component shown above contains two other components, as
displayed in the central area
A component may refer to:
A specific component

There are three components in the figure
above: the Pumping System and two Pump
Units.

A component with its contained components A Pump Unit, as pictured above, typically
and all components and sub-components they contains components such as a pump and a
comprise)
flow meter. It is a subtree whose root is the
Pumping System component.
The Pumping System component itself is a
subtree whose root may be, for example, a
lubrication system.
Note:

Although multiple trees can exist in a project, this situation is not recommended.
TBA: Yes, let’s move this someplace else.

Component Types
There are two types of components: physical and logical.
Any controlled system consists of physical devices, such as motors, pressure
transmitters and warning lights. These physical devices have no internal control. They
merely receive signals from, and send signals to, the control system. In WonderLogix
Studio, such devices are represented as PHYSICAL COMPONENTS.
L OGICAL COMPONENTS represent parts of the control system. Each logical component may
contain other components, both physical and logical, that are required to achieve its
functionality.
Consider, as an example, a pumping system that consists of two pumps (main and
backup), each with its own discharge valve. This system is best modelled in
WonderLogix Studio by a PUMPING SYSTEM LOGICAL COMPONENT containing two PUMPING
UNIT LOGICAL COMPONENTS. Each Pumping Unit contains two physical components: a
Pump and a Valve.
The Pumping Unit is an additional level of abstraction. This level is not necessary, since
the Pumping System could contain all physical components. However, it is highly
beneficial. See Pump Unit Module on page 53 for more information.
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Figure 47: Component Types

(A)

(B)

(C)

(A) The tree structure of the Pumping System as displayed in the model navigation tree.
Physical components are colored in purple and contain no further components.
(B) A Pump Unit logical component, as displayed in the central area, which contains
(C) Two physical components

Component Class
A CLASS is a template for creating components with identical structure and
functionality, which are called INSTANCES of that class. For example, a Valve class has
two instances: Inlet Valve and Outlet Valve.
A class is created from an existing component when you wish to create more entities
that have the same structure and functionality as the original component and to keep
them linked together.
All instances of a class have identical structure and functionality. Any substantial
change made to any of the instances is reflected in all other instances.
Substantial changes include:
• Adding, removing, or editing a component, an attribute, or its defined logic
• Changing the name of a contained component but not the instance itself
• Internal changes to a state machine or bitset
Note:

WonderLogix Studio does not support inheritance.
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Component Duplication
If you want to create a component similar to an existing one, you may duplicate the
existing component with a copy/paste operation and then modify the duplicate. A
pasted component has no connection with the original component, or any other pasted
components, so changing one of these components has no effect on any of the others.
An exception is when the pasted component contains sub-components which are an
instance of a class. These will be recreated in the pasted components as new instances
of that class, which keeps them linked to the original sub-component.
Note:

It is highly recommended to use classes rather than duplication whenever possible.

Array of Components
An ARRAY is a special component that contains multiple instances of a certain class.
These instances are called the ELEMENTS of the array. An example might be an array of
four aerators.
An array is used when there is no need to distinguish, in terms of functionality,
between the elements. For example, in order to balance their working hours, every time
another aerator is required to operate, you want to choose the one with minimal
working hours, regardless of whether it is aerator 1, 2, 3, or 4.
Figure 48: Array of Components

Component Locking and Sealing
In order to protect a model from accidental changes, you can lock a component with or
without a password. When a component is locked, the component and all of its
contained components can no longer be changed.
Note:
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For example, you have placed instances of the class On-Off Motor in Sub-System A, as
well as in other places in the model, outside of that sub-system. If you lock Sub-System
A, the On-Off Motor within it is also locked, as well as all other instances of that class,
including those outside of the Sub-System A hierarchy.
Nested locking is possible and must be done bottom-up. Nested unlocking must be done
top-down. The navigation tree marks the components that are directly locked with a
lock icon.
Figure 49: Locked Component

(A)

(B)

(A) Lock icon in navigation tree
(B) Lock icon in current component
When a component is exported, you must define whether or not it is locked.
Some components created from an imported class (a .wso file) made by WonderLogix
may be system-locked, meaning that they cannot be unlocked by the user. Typically, a
system-locked component is converted to a predefined PLC code, such as a PID class,
and for this reason, any changes to it are forbidden.
Note:

Locking is not reflected in the PLC code.

In order to prevent accidental changes in the PLC code, you can seal a component.
During the sealing process, Studio 5000 is used to generate encrypted PLC code that can
be modified only in Studio 5000 after breaking the seal.
Note:

Only instances of a class can be sealed.
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Figure 50: Locked and Sealed Component

Attributes
An ATTRIBUTE is a data holder and part of a component. For example, a Pump
component can have an Operate Boolean Input and a General Failure internal Boolean
Property.
Different types of attributes exist, such as input, output, and parameter. An attribute has
a data type, such as Boolean or Analog, and Value, such as True or 1.0. The initial value
is set by the user and updated by the logic associated to the attribute, if any.
Attributes are classified according to their type and data type:
Attribute

Possible Date Types

Input

• Undefined
• Boolean
• Analog

Output

• Undefined
• Boolean
• Analog

State machine
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Attribute

Possible Date Types

Property

• Undefined
• Boolean
• Analog
• Timer
• Counter

Parameter

• Undefined
• Boolean
• Analog
• String
• Bitset

Attribute Types
Attribute types are divided into two groups: interface attribute types and internal
attribute types.
Figure 51: Attribute Types

(A)

(B)

(C)

(A) Interface input
(B) Interface output
(C) Internal attributes
The inputs and outputs of a component are called its interface attributes since they are
the means for it to interact with the rest of the model. Attributes of all other types—
State machine, Property, and Parameter—are internal attributes, accessible only inside
their component, and which serve to implement its functionality.
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Interface Attributes
There are two types of interface attributes.

Input
Inputs are displayed in the GUI as an arrow entering the component. An Input is the
only way for the model to send a value into the component.
Note:

The value of an input is determined outside of the component, in the scope of its
parent component, but is not accessible outside it. In other words, you cannot refer
to the value of an input when you are at the parent’s scope.

Create an Input when you want to send a command to a component or pass any other
data to a component. For example, a Tank component might have these two inputs:
• Boolean input named Regulate Level
• Analog input named Required Level
Note:

For boolean inputs that are commands to the component, as in the example
“Regulate Level,” always use the imperative form of the verb. See How to Build a
Model on page 23 for more information about recommended naming
conventions.

An example of how the tank performs its functionality, or regulates its level, is as
follows:
1. When the Regulate Level input is true (or is on), a filling valve is opened.
2. The filling valve remains open until it has reached the level defined in the Required
Level input.
Note:

An Input of a physical component is actually an output of the control system
sent to the field (O in the I/O notation) and it is listed as an output in the I/O list.
For example, an Open command to a valve is a physical output of the control
system and an input to the physical valve.

Output
Outputs are displayed in the GUI as an arrow leaving the component. An output is the
only way for a component to send a value to the rest of the model.
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Note:

The value of an output is determined inside the component, but is not accessible
inside it.

The HMI can interact with the internals of a component directly, not through its inputs
and outputs, but it is not considered part of the model.
Consider the following analogy. Components are like departments in a building. You
can only move between them by going up and down the stairs, and you cannot go from
floor one to floor three without passing through floor two.
However, the HMI stands outside of this building, and can access every floor (and every
variable) in the model.
Create an output when you want the component to report its state, request an operation
from another component, or send out any other data. For example, a Tank component
might have these two outputs:
• Boolean output named Operate Filling Pump (or Filling Pump Required)
• Analog output named Deviation from Required Level
The tank sets Operate Filling Pump according to the same internal conditions used to
open its (contained) filling valve. Setting this output indicates the tank’s request to turn
on an external filling pump. The tank also continuously reports the difference between
its measured level from the requested level (received as an input).
Note:

An Output of a physical component is actually an input of the control system
received from the field (I in the I/O notation) and it is listed as an input in the I/O
list.
For example, the feedback Fully Closed of a valve is a physical input to the control
system and an output from the physical valve.

WonderLogix Studio User Guide

113

Concepts

Figure 52: Interface Attributes

(A)

(B)

(A) Digital outputs
(B) Digital inputs
Note:

Remember that (A), Operate and Open, are physical outputs of the control
system. In the model they are inputs into the components. Likewise, (B),
Overload, Fully Open, and Fully Closed, are physical inputs of the control
system. In the model they are outputs from the components.

Internal Attributes
There are three internal attributes.

State Machine
A STATE MACHINE is displayed in the GUI as an item in the State Machines list in the
right panel. A state machine is an abstract machine that can be in exactly one of its
states at any given time. The state machine can change from one state to another when a
certain condition is fulfilled—the change from one state to another is called a
transition. A state machine must have one of its states defined as the initial state.
Every logical component, except arrays, can have one or more independent state
machines.
Create a state machine when the component has distinct states. For example, a Motor
component can have a state machine called Mode with the following states: Auto,
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Manual, and Maintenance. The motor has different functionality in each mode, which is
to say, in each state.
Figure 53: Mode State Machine

Property
A PROPERTY is displayed in the GUI as an item in the Properties list in the right panel.
Create a property when you want to:

Hold a value that is determined and used inside the component
This is in contrast with an Input whose value is determined outside of the component,
and an Output, which cannot be used inside the component. For example, property Aux.
Systems OK concentrates all permissive conditions to allow state transition from Starting
to Ready. It is calculated inside the component and used inside it as well.
Note:

If such a value is also required outside of the component, an Output must be
created (possibly with the same name as the property) reflecting the value of the
property.

Note:

Self-reference (i.e. an attribute whose updated value depends on its previous one)
also falls under this category. An example might be the following: The On Off
Motor clears the property Inhibited from the moment property Inhibited is on for a
consecutive time of 30 seconds.
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Create a timer or counter
Although time and count constraints can be introduced directly into the logic, a timer
or counter attribute allows for more advanced functionality and can also be accessed
from the HMI. For example, property Motor Starts counts the times a motor was started
and can be displayed on the HMI.

Simplify complex logic
Define one or more properties to execute parts of a complex logic. Combine these
properties to achieve the final value.

Parameter
A PARAMETER is displayed in the GUI as an item in the Parameters list in the right
panel. Create a parameter to hold a value that is not updated by the model but might be
updated from the HMI. Using a parameter instead of an arbitrary value clarifies the
meaning of the value by naming it. In addition, if the parameter is used multiple times,
only a single change is required instead of multiple value changes. For example, the
parameter Maximal Pressure holds the value above which an alarm is triggered.
Figure 54: Properties and Parameters
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Attribute Data Types
When an attribute is created, it has no defined data type (except for State Machine).
Usually, the attribute receives its data type when it participates in a logic sentence. The
data type of the attribute is derived according to its context in the sentence. Using
Operate Motor only while... as an example, a Boolean data type would be derived for the
Operate input of the Motor component.
Data type can also be assigned manually in the attribute’s Details panel by selecting from
the available data types.
Note:

The special parameter types String and Bitset must be assigned manually.

Once an attribute participates in a sentence, its type can no longer be changed
manually. These are the regular data types:
Data Type

Explanation

Boolean

True or false value

Analog

Real number with minimum and maximum used for scaling

Counter

Count of events with an optional limit. Can count up or down

Timer

Time measurement in seconds, minutes, hours or days with an optional limit.
Can measure consecutive time (resets implicitly when timing condition is
false) or total time (resets when explicitly asked to).

Two special data types exist for a parameter. These types are available by clicking
File > Settings > Control Engineer.
Special Data Type

Explanation

String

Holds a string, typically to be displayed or updated by the HMI

Bitset

A collection of 32 bits, typically concentrating various Boolean
values written or read by the HMI. Using Bitsets is a common
practice when using an HMI such as Wonderware or Citect, which
charge by variables or points.

Attributes of Arrays
Arrays can have only inputs and outputs—the same inputs and outputs of their
elements. You cannot directly add or remove an array’s inputs and outputs, only
indirectly by modifying one of its elements.
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Logic
The English sentences that define the value of an attribute are called the attribute’s
L OGIC.
For example, the value of the Operate Boolean input of a Motor component is
determined by the following logic associated to it: Operate Motor only while Switch is
Pressed. This logic is converted into PLC code that sets Operate if the value of Pressed
(another Boolean attribute) is true and will clear Operate if the value is false.
Figure 55: Logic

Logic can be associated with any attribute except Parameters and Outputs of physical
components.
Logic is defined by the user using the Logic Editor, typically by making repeated
selections from the suggested options. The Logic Editor is always opened for a specific
attribute, which is called the Subject. The defined logic is associated to the subject and
defines its value.
Figure 56: Logic Editor

The structure of most logic sentences is: Action + Connector + Trigger
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Figure 57: Logic Structure

The action describes a certain value modification of the subject. For example, Operate
Motor means Set the Boolean attribute Operate. The trigger, together with the connector,
describes when and how this action will take place. For example, only while + Switch is
Pressed means that Operate is set only if Pressed is true. From the moment + Switch is
Pressed means Operate is set the moment Pressed is true and remains set even if Pressed
becomes false. Another sentence is required to define when to clear Operate.

Logic Action
Different actions can be defined, depending on the data type of the subject. If the data
type is not yet defined, multiple actions are available according to the allowed data
types for the attribute's type. If the data type of the attribute is defined, only the one
appropriate action will be available.
Data Type

Available Actions

Boolean

• Set
• Clear
• Toggle (change to opposite value)

Analog

• Make equal to (move)
• Ramp to

Timer

Measure consecutive or total time, possibly repeatedly, possibly with a certain
limit

Counter

Count up or down, possibly repeatedly, possibly with a certain limit

Logic Connector
Logic connectors are displayed according to the context. Most possible options are:
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Logic Connector

Meaning

Only while

Action takes place if and only if the trigger is true

From the moment

Action takes place the moment the trigger turns true until an
opposite action is taken (defined by a different sentence)

Just once when, every time Action takes place momentarily every time the trigger turns true
Always

Action takes place always (no trigger)

Logic Trigger
The trigger consists of one condition or a combination of conditions. For example
…Switch is Pressed is a single condition referring to the Boolean attribute Pressed. The
following trigger: …all of the following is met when:
• Tank is Full
• Pressure of Tank is greater than 20
• Week day is Monday
The trigger consists of three conditions that are “And-ed,” that is to say, the trigger is
true if and only if all three conditions are true. The first refers to the boolean attribute
Full, the second condition refers to the analog attribute Pressure and the third condition
refers implicitly to a global variable holding the day of week.
The different basic conditions are:
Basic Condition

Explanation

Boolean

• Check if a value is set
• Clear

Analog:

• Check if a value is greater/lower than another value
• Check if a value changed

Timer/Counter

• Check if the timer/counter is done (if a limit is defined)
• Check if the measured/remaining time/count is more/less than a
certain value

Clock/Date/Day

Check
• Clock time
• Date
• Day of week

State

Check the current state of a state machine

Bitset

Check if a specific bit in a bitset is set or clear
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Each basic condition can be altered into a different condition by a constraint:
Constraint

Explanation

Consecutive time Makes a condition which is true if the basic condition it follows is true
constraint
consecutively for a certain time. For example: …Switch is pressed for a
consecutive time of 3 seconds.
Total time
constraint

Makes a condition which is true if the basic condition it follows is true for a
certain accumulated time since a certain event. For example: …Filter is Active
for a total time of 24 Hours since Filter is requested to Wash.

Logic of Arrays
An array allows you to define powerful logic on its inputs, such as this example: Start
additional 2 pumps with minimal working hours of those which are ready from the moment
Pressure of Tank is greater than 20.
For an input of an array, the logic action includes a combination of three possible
operations:
Logic Option

Explanation

Filtering

Allow application of the action only to elements which have a certain
Boolean output set. In the example above, any pump which does not have its
Ready Boolean output set will not be started.

Sorting

Sort the elements according to a certain analog output. In the example above,
pumps are sorted according to their Working Hours analog output. If you
want to act on a specific number of elements (in the example above, 2), you
must add sorting to determine how elements are selected. If there is no real
criterion (for example, Working Hours) to sort the elements, add an analog
output named Order and assign the required order to it—typically 1, 2, 3...

Selecting

Select one or more elements to apply the action to, by their sorted order and
only if they pass filtering. In the example above, up to two pumps are
selected. Note that since filtering is applied, there may not be two pumps
ready and fewer pumps than requested, or even none, will be started.

Logic cannot be defined on outputs of arrays. Instead, certain checks and manipulations
can be defined on them when they are used in the trigger, as in this example: … the
maximal Pressure of any Pump which is Running.
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Additional Logic Sentences
These are additional logic sentences available.

Complementary Logic Sentences
In some cases, the logic might not define the value of an attribute at all times.
For example, make Required Speed equal to 0 when System is not Enabled is probably not
sufficient, since the value of Required Speed is not defined when the system is enabled.
In such cases, WonderLogix Studio pops an additional sentence to help make the logic
complete by defining the value of the subject at any given moment. If the necessity of
the additional sentence is not certain, it will be marked as optional.

Resolvers
In some cases, a special additional sentence—called a resolver—is added to the existing
logic to prevent ambiguity.
For example, look at these two sentences:
• Motor sets Running from the moment Start Switch is Pressed
• Motor clears Running from the moment Stop Switch is Pressed
This includes a certain ambiguity: What happens when both buttons are pressed? In
such a case WonderLogix Studio pops an additional sentence (In case of conflict, Motor
sets/clears Running) to allow you to resolve this conflict by specifying the requested
behavior.

Advanced Options
The logic editor allows you to add some advanced options to the logic sentences:
Ramp/ROC.
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Advanced Option

Explanation

Ramp

Limit the rate at which the value of an analog variable changes
towards another value.

ROC (Rate of Change)

Allows you to check the Rate Of Change of an analog value

Numeric modification

Modify numeric values by applying simple arithmetic operations
• Add
• Subtract
• Multiply
• Divide
• Absolute value

Clock/Date/Week Day

Allows you to refer to time and dates as set in the PLC clock

Figure 58: Advanced Logic Options
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